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Ďakujeme za zakúpenie nášho produktu. V prípade akýchkoľvek otázok alebo požiadaviek neváhajte a obráťte sa 
na predajcu. 

Autorské práva 

Autorské práva NSS Ltd. Všetky práva vyhradené. Žiadna časť tejto príručky sa nesmie kopírovať, 
reprodukovať, prekladať ani distribuovať v žiadnej forme a žiadnymi prostriedkami bez predchádzajúceho 
písomného súhlasu našej spoločnosti. 

 

Potvrdenie o ochrannej známke 

 a iné ochranné známky a logá spoločnosti BCS Point sú majetkom spoločnosti NSS Ltd. Iné 

ochranné známky, názvy spoločností a názvy produktov v tejto príručke sú majetkom príslušných vlastníkov. 

Odmietnutie zodpovednosti 

 
POZOR! 
Predvolené heslo sa používa na prvé prihlásenie. Heslo zmeňte po prvom prihlásení, aby sa zaistilo 
zabezpečenie účtu. Odporúčame vám nastaviť silné heslo (nie menej ako osem znakov). 

 

 V maximálnej možnej miere povolenej príslušnými zákonmi je opísaný produkt s príslušným 
hardvérom, softvérom, firmvérom a dokumentmi poskytovaný na báze „v stave, v akom je“. 

 Vynaložili sme najlepšie úsilie na overenie úplnosti a správnosti obsahu tejto príručky, ale žiadny 
výrok, informácia alebo odporúčanie v tejto príručke nepredstavuje formálnu záruku žiadneho druhu, 
výslovnú alebo implicitnú. Nenesieme zodpovednosť za žiadne technické alebo typografické chyby v 
tejto príručke. Obsah tejto príručky podlieha zmenám bez predchádzajúceho oznámenia. Aktualizácia 
sa pridá do novej verzie tejto príručky. 

 Za používanie tohto návodu a následný výsledok zodpovedá iba používateľ. V žiadnom prípade 
nebudeme zodpovedať za žiadne nezvyčajné, následné, náhodné ani nepriame poškodenia, okrem 
iného aj vrátane škôd spôsobených stratou podnikateľských ziskov, prerušením podnikania, alebo 
stratou údajov, alebo dokumentácie v súvislosti s používaním tohto produktu. 

 Bezpečnostné monitorovanie pomocou videa a zvuku môže byť regulované zákonmi, ktoré sa v 
jednotlivých krajinách líšia. Pred používaním tohto produktu na bezpečnostné účely si overte zákony 
vo vašom regióne. Nenesieme zodpovednosť za žiadne dôsledky, ktoré vyplývajú z nelegálnej 
prevádzky zariadenia. 

 Ilustrácie v tejto príručke slúžia iba na účely referencie a môžu sa líšiť v závislosti od verzie alebo 
modelu. Snímky obrazovky v tejto príručke mohli byť prispôsobené, aby spĺňali určité požiadavky a 
preferencie používateľov. V dôsledku toho sa môžu niektoré uvádzané príklady a funkcie líšiť od 
zobrazenia na vašom monitore. 

 Táto príručka slúži ako návod pre viac modelov produktov a preto nie je určená pre konkrétny produkt. 

 V dôsledku neistoty, napríklad fyzického prostredia, môže existovať rozdiel medzi skutočnými a 
referenčnými hodnotami uvedenými v tejto príručke. Naša spoločnosť má záverečné právo na 
interpretáciu. 
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Ochrana životného prostredia 
Tento produkt sa navrhol tak, aby spĺňal požiadavky na ochranu životného prostredia. Na správne 
skladovanie, používanie a likvidáciu tohto produktu je potrebné dodržiavať vnútroštátne zákony a predpisy. 

Symboly 

V tejto príručke môžete nájsť symboly uvedené v nasledujúcej tabuľke. Postupujte pozorne podľa pokynov, 
ktoré zobrazujú príslušné symboly, aby ste sa vyhli nebezpečným situáciám a používali produkt správne. 

Symbol Popis 

VÝSTRAHA! 
Obsahuje dôležité bezpečnostné pokyny a upozorňuje na situácie, ktoré by mohli 
spôsobiť zranenie. 

POZOR! 
Upozorňuje čitateľa, aby bol opatrný, pričom nesprávna prevádzka môže spôsobiť 
poškodenie alebo nesprávne fungovanie produktu. 

UPOZORNENIE! Znamená užitočnú alebo dodatočnú informáciu o používaní produktu. 
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1  Sieťové pripojenie 

Pred prístupom k sieťovej kamere (známej aj ako IP kamera alebo IPC) z počítača je potrebné sieťovú 
kameru priamo pripojiť k počítaču pomocou sieťového kábla alebo prostredníctvom prepínača, alebo 
smerovača. 

 
Na pripojenie sieťových rozhraní sieťovej kamery a počítača používajte kábel s tieneným krúteným párom 
(STP). 

 

Na pripojenie sieťových rozhraní kamery a prepínača alebo smerovača používajte káble s tieneným 
krúteným párom (STP). 

2  Prihlásenie 

Príprava 
Po dokončení inštalácie podľa stručnej príručky pripojte kameru k napájaniu, aby sa spustila. Po spustení 
kamery k nej môžete získať prístup z klientskeho počítača, ktorý má nainštalovaný internetový prehliadač 
alebo klientsku softvérovú stanicu BCS Point. Odporúčaným internetovým prehliadačom je Internet 
Explorer (IE). Ďalšie informácie o stanici BCS Point nájdete v návode na použitie stanice BCS Point. 

V nasledujúcej časti sa ako príklad uvádza prehliadač IE používaný v operačnom systéme Microsoft 
Windows 7.0. 

Kontrola pred prihlásením 

 Kamera funguje správne. 

 Sieťové pripojenie medzi počítačom a kamerou je normálne. 

 Počítač má nainštalovaný prehliadač Internet Explorer 8.0 alebo novší. 

 Rozlíšenie je nastavené na 1440 x 900 (voliteľné). 

IPC PCSwitch or Router

Network cable Network cable

Sieťový kábel 

Sieťový kábel 

Prepínač alebo smerovač 

Sieťový kábel

Počítač IPC 

Počítač IPC 
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Pridanie adresy IP ako dôveryhodnej lokality 

 

 

Zrušte začiarknutie políčka 
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 UPOZORNENIE! 
V príklade je uvedená adresa IP 192.168.0.13/192.168.1.13 ako predvolená adresa IP. Nahraďte ju aktuálnou 
adresou kamery, ak sa zmenila. 

 

Úprava ovládacích nastavení používateľského prístupu (voliteľné) 

Pred prístupom ku kamere postupujte podľa krokov nastavenia položky User Account Control Settings na 
možnosť Never notify. 

 

Prihlásenie do webového rozhrania 
Predvolená statická adresa IP kamery je 192.168.1.13 or 192.168.0.13 a predvolená maska podsiete je 
255.255.255.0. 

Server DHCP je predvolene zapnutý. Ak sa server DHCP používa v sieti, adresa IP kamery sa môže priradiť 
dynamicky a na prihlásenie bude potrebné použiť správnu adresu IP. Na zobrazenie dynamickej adresy IP 
kamery použite klienta BCS Point. 

V nasledujúcej časti je na popis postupu prihlásenia použitý prehliadač IE. 

1. Prejdite na stránku prihlásenia zadaním správnej adresy IP kamery do poľa adresy. 

 

2. Ak sa prihlasujete prvýkrát, postupujte podľa pokynov a nainštalujte platformu ActiveX. Na 
dokončenie inštalácie je potrebné zatvoriť prehliadač. 
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 UPOZORNENIE! 
 Ak chcete načítať platformu ActiveX manuálne, zadajte http://IP address/ActiveX/Setup.exe do 

poľa adresy a stlačte kláves Enter. 
 Predvolené heslo sa používa na prvé prihlásenie. Heslo zmeňte po prvom prihlásení, aby sa zaistilo 

zabezpečenie účtu. Odporúčame vám nastaviť silné heslo (nie menej ako osem znakov). 
 Kamera sa sama chráni pred ilegálnym prístupom, a to obmedzením počtu neúspešných pokusov 

o prihlásenie. Ak sa prihlásenie zlyhá šesťkrát za sebou, kamera sa automaticky zablokuje na desať 
minút. 

 

3. Zadajte používateľské meno a heslo a potom kliknite na položku Login. V prípade prvého prihlásenia je 
predvolené používateľské meno „admin“ a heslo „123456“. 

 Ak sa prihlasujete a máte vybratú možnosť Live View, po prihlásení sa zobrazí živé video. V opačnom 
prípade je potrebné spustiť živé video manuálne v okne živého náhľadu. 

 Ak sa prihlasujete a máte vybratú možnosť Save Password nebude potrebné zadať heslo pri každom 
prihlásení. Kvôli zaručeniu zabezpečenia neodporúčame vybrať možnosť Save Password. 

 Ak chcete vymazať textové polia Username a Password a začiarkavacie políčko Save Password, 
kliknite na položku Reset.  

Úvod k webovému rozhraniu 
Pri prihlásení do webového rozhrania sa predvolene zobrazuje okno živého náhľadu. Nižšie je uvedený 
príklad. 

 

Č. Popis 

1 Ponuka 

2 
Oblasť ovládania PTZ 

Poznámka: 
Táto oblasť je k dispozícii v prípade kupolových kamier PTZ a kamier PTZ. 

3 Okno živého náhľadu 

4 Panel nástrojov živého náhľadu 
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Počiatočná konfigurácia 

Po prihlásení do zariadenia vykonajte nasledujúcu počiatočnú konfiguráciu. 

Položka Popis 

1. Nastavenie adresy TCP/IP zariadenia. Opätovná konfigurácia parametrov IP a siete zariadenia na 
základe aktuálneho sieťového pripojenia. 

2. Odhlásenie a opätovné prihlásenie na 
internet použitím novej adresy IP. - 

3. Nastavenie času systému. Nastavenie času systému na základe aktuálnej situácie. 

4. Nastavenie servera správy (voliteľné). Nastavenie servera správy na základe aktuálneho sieťového 
pripojenia. 

5. Nastavenie servera na ukladanie 
fotografií (voliteľné). 

Nastavenie servera na ukladanie fotografií na základe 
aktuálneho sieťového pripojenia. 

6. Nastavenie OSD. Nastavenie informácií zobrazovaných na obrazovke podľa 
potreby, napr. času. 

7. Správa používateľov (voliteľná). Zmena predvoleného hesla a pridanie bežných používateľov 
podľa potreby. 

 

Po dokončení počiatočnej konfigurácie môžete sledovať živé video. Podľa potreby nakonfigurujte ďalšie 
parametre. 

 UPOZORNENIE! 
 Zobrazené rozhranie živého náhľadu, zobrazené parametre a rozsahy hodnôt sa môžu líšiť 

v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 
 Parametre, ktoré sú zobrazené sivou, nie je možné upraviť. Aktuálne nastavenia nájdete v rámci 

webového rozhrania. 
 Odporúčame, aby ste si po prvom prihlásení zmenili heslo. Podrobnosti o spôsobe zmeny hesla 

nájdete v časti Zabezpečenie. 

 

3  Konfigurácia parametrov 

Lokálne parametre 
Nastavte lokálne parametre počítača. 

 UPOZORNENIE! 
Lokálne parametre sa môžu meniť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho webového 
rozhrania. 
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1. Vyberte položky Setup > Common > Local Settings. 

 

2. Podľa potreby upravte nastavenia. Nasledujúca tabuľka obsahuje popis niektorých hlavných 
parametrov. 

Parameter Popis 

Intelligent 
Mark 

Untriggered 
Target 

Ak je táto možnosť zapnutá, kamera zobrazí na obrazovke značku na danom 
cieli (napr. tvár, keď je zapnutá detekcia tváre) a bude ju sledovať. 

Video 

Processing Mode 

 Priorita reálneho času: Odporúča sa, ak je sieť v dobrom stave. 
 Priorita plynulosti: Odporúča sa v prípade potreby krátkeho oneskorenia 

pre živé video. 
 Mimoriadne nízke oneskorenie: Odporúča sa v prípade potreby 

minimálneho oneskorenia pre živé video. 

Protocol Nastavenie protokolu používaného na prenos mediálnych streamov, ktoré je 
potrebné dekódovať pomocou počítača. 

Record 
and 
Snapshot 

Recording 

 Pododdiel podľa času: Trvanie nahrávaného videa v prípade každého 
súboru nahrávania v počítači. Napr. 2 minúty. 

 Pododdiel podľa veľkosti: Veľkosť každého súboru nahrávania uloženého 
v počítači. Napr. 5 M. 

Record 
Overwrite 

 Prepísanie: Po využití priradeného priestoru úložiska v počítači kamera 
odstráni existujúce súbory nahrávania, aby sa vytvoril priestor pre nový 
súbor nahrávania. 

 Úplné zastavenie: Po využití priradeného priestoru úložiska v počítači sa 
nahrávanie automaticky zastaví. 

 

3. Kliknite na položku Save. 
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Konfigurácia siete 

Ethernet 

Upravte nastavenia komunikácie, ako je napr. adresa IP kamery tak, aby kamera mohla komunikovať s inými 
zariadeniami. 

 UPOZORNENIE! 
 Po zmene adresy IP je potrebné na prihlásenie použiť novú adresu IP. 
 Konfigurácie servera DNS (Domain Name System, systém názvov domén) sa vzťahujú na prístup 

k zariadeniu podľa názvu domény. 

 

Statická adresa 

1. Kliknite na položky Setup > Network > Network. 

  
2. Vyberte možnosť Static z rozbaľovacieho zoznamu Obtain IP Address. 

3. Zadajte adresu IP, masku podsiete a predvolenú adresu brány. Uistite sa, že adresa IP kamery je v sieti 
jedinečná. 

4. Kliknite na položku Save. 

PPPoE 

 UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

Ak je kamera pripojená k sieti prostredníctvom pripojenia s nemennými bodmi cez sieť Etherner (PPPoE), 
ako režim získania IP je potrebné vybrať možnosť PPPoE. 

1. Kliknite na položky Setup > Network > Network. 
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2. Vyberte možnosť PPPoE z rozbaľovacieho zoznamu Obtain IP Address. 

3. Zadajte používateľské meno a heslo poskytnuté internetovým servisným poskytovateľom (ISP). 

4. Kliknite na položku Save. 

DHCP 

Systém dynamického prideľovania adries (DHCP) je pri dodaní kamery predvolene zapnutý. Ak je v sieti 
zavedený server DHCP, kamera môže automaticky získať adresu IP zo servera DHCP. 

Ak chcete manuálne nastaviť DHCP, postupujte podľa nižšie uvedených krokov: 

1. Kliknite na položky Setup > Network > Network. 

 

2. Vyberte možnosť DHCP z rozbaľovacieho zoznamu Obtain IP Address. 

3. Kliknite na položku Save. 

IPv6 

1. Kliknite na položky Setup > Network > Network. 

 
2. Predvolene je režim IPv6 nastavený na možnosť Manual. 
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3. Zadajte adresu IPv6, nastavte dĺžku predpony a predvolenú bránu. Adresa IP musí byť v sieti jedinečná. 

4. Kliknite na položku Save. 

Wi-Fi 

 UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu, podrobnosti nájdete v popise aktuálneho modelu. 

1. Kliknite na položky Setup > Network > Network. Kliknite na kartu Wi-Fi. 

 
2. Vyberte položku Sniffer. 

3. Kliknite na položku Save. 

Niektorú zariadenia dokážu vyhľadávať siete Wi-Fi a pripojiť sa. 

1. Vyberte položky Setup > Network > Network. Vyberte položku Wi-Fi alebo Wi-Fi Mode. 

 
2. Zobrazí sa intenzita signálu. Zapnite možnosť Adaptive Streams. Na stránke sa zobrazí, že existujú iné 

siete Wi-Fi. Ak chcete opätovne vyhľadať sieť Wi-Fi, kliknite na položku Search. 

3. Kliknite na položku SSID v zozname sietí Wi-Fi. Zobrazia sa informácie o príslušnej sieti. 

4. Kliknite na položku Save. 

5. Keď je položka Wi-Fi Mode nastavená na možnosť Wi-Fi Hotspot, kamera bude fungovať ako Wi-Fi 
hotspot pre iné zariadenia. 
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6. Kliknite na položku Save. 

Port 

 UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

1. Kliknite na položky Setup > Network > Port. 

 
2. Nakonfigurujte príslušné čísla portu. 

3. Kliknite na položku Save. 

FTP 

Po konfigurácii FTP budete môcť nahrávať snímky zo sieťových kamier na špecifický server FTP. 

Všeobecné 

1. Kliknite na položky Setup > Storage > FTP. Prejdite na kartu General. 

 

BCSPOINTWIFI
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2. Nastavte adresu IP a port pre server FTP, používateľské meno a heslo používané na nahrávanie snímok 
na server FTP, vyberte položky Upload Images, Overwrite Storage a nastavte Overwrite At (prahová 
hodnota na prepísanie snímok). Niektoré modely kamier podporujú test FTP. Test FTP je možné 
vykonať po správnom dokončení nastavení FTP. 

3. Nastavte cestu na uloženie snímok na server FTP a formát názvu súborov. Nastavte cestu napríklad 
ako číslo predvoľby.\\adresa IP \\dátum\\hodina a názov súboru ako číslo predvoľby.-priblíženie 
PTZ-šírka PTZ-dĺžka PTZ.jpg. 

4. Kliknite na položku Save. 

Inteligentné 

Táto funkcia sa používa na uloženie snímok zaznamenaných v prípade inteligentných funkcií, ako sú 
rozpoznávanie tváre a počítanie ľudí. 

1. Kliknite na položky Setup > Storage > FTP. Prejdite na kartu Smart. 

 
2. Nastavte adresu IP a port pre server FTP, používateľské meno a heslo používané na nahrávanie snímok 

na server FTP. 

3. Nastavte cestu na uloženie snímok na server FTP a formát názvu súborov. Nastavte cestu napríklad 
ako číslo predvoľby.\\adresa IP \\dátum a názov súboru ako číslo predvoľby.-šírka PTZ-dĺžka 
PTZ-priblíženie PTZ.jpg. 

4. Kliknite na položku Save. 
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E-Mail 

Po konfigurácii e-mailu a spustení alarmu budete môcť odosielať hlásenia na konkrétnu e-mailovú adresu. 

1. Kliknite na položky Setup > Network > E-mail. 

 

 

2. Nakonfigurujte príslušné parametre odosielateľa a príjemcu. Niektoré modely kamier podporujú test 
e-mailu. E-mail bude možné otestovať po nastavení adresy príjemcu. Nasledujúca tabuľka obsahuje 
popis niektorých hlavných parametrov. 

Parameter Popis 

TLS/SSL 

V prípade zapnutia bude e-mail šifrovaný pomocou TLS (bezpečnostná prenosová vrstva) 
alebo SSL (bezpečná objímková vrstva), aby sa ochránili osobné údaje. 

Najprv prebehne pokus o pripojenie prostredníctvom SSL. Ak server SMTP podporuje SSL, 
e-mail sa odošle prostredníctvom pripojenia SSL; v opačnom prípade prebehne pokus 
o odoslanie použitím protokolu STARTTLS. 

Attach Image V prípade zapnutia bude e-mail obsahovať ako prílohu 3 okamžité snímky podľa intervalu 
záznamu. 

 

3. Kliknite na položku Save. 

Mapovanie portov  

1. Kliknite na položky Setup > Network > Port. Prejdite na kartu Port Mapping. 
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2. Zapnite možnosť Port Mapping a vyberte typ mapovania. Ak je vybratá možnosť Manual, musia byť 
nakonfigurované externé porty (kamera automaticky získa externé IP). Ak je nakonfigurovaný port 
obsadený, položka Status sa bude zobrazovať ako neaktívna. 

3. Kliknite na položku Save. 

DNS 

1. Kliknite na položky Setup > Network > DNS. 

 

2. Nastavte adresy servera DNS. 

3. Kliknite na položku Save. 

DDNS  

 UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Setup > Network > DDNS. 

 
2. Zapnite DDNS Service. 

3. Vyberte typ DDNS: DynDNS, NO-IP alebo EZDDNS. 

4. Dokončite ďalšie nastavenia vrátane adresy servera, názvu domény, používateľského mena a hesla. 

5. Kliknite na položku Save. 
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P2P 

 UPOZORNENIE! 
 Táto funkcia nie je dostupná u všetkých modelov. 
 Táto funkcia sa v prípade niektorých zariadení zobrazuje ako P2P. 

 

1. Kliknite na položky Setup > Network > P2P. 

 

2. Vyberte možnosť On, aby ste zapli službu cloudu. 

3. Kliknite na položku Save. 

802.1x 

802.1x umožňuje overenie zariadeniam (napr.kamerám), ktoré sa pokúšajú o pripojenie k sieti. K sieti sa 
môžu pripojiť iba overené zariadenia. Zaručuje sa tým zabezpečenie. 

1. Kliknite na položky Setup > Network > 802.1x. 

 
2. Vyberte možnosť On a potom dokončite ďalšie nastavenia. 

3. Kliknite na položku Save. 

Konfigurácia obrazu 

Úprava obrazu 

 UPOZORNENIE! 
 Zobrazené parametre obrazu a rozsahy hodnôt sa môžu líšiť v závislosti od modelu kameru. 

Skutočné parametre a rozsahy hodnôt kamery nájdete v rámci webového rozhrania. Ak chcete 
upraviť nastavenia, môžete posunúť jazdce alebo priamo zadať hodnoty do textových polí. 

 Kliknutím na položku Default sa obnovia všetky predvolené nastavenia obrazu. 

 

www.star4live.com
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Nastavenie scény 

Nastavte parametre obrazu, aby ste dosiahli požadované obrazové efekty na základe živého videa v rôznych 
scénach. 

Kliknite na položky Setup > Image > Image. 

Stránka správy scény v prípade niektorých modelov sa zobrazuje tak, ako je uvedené nižšie, pričom môžete 
vybrať požadovanú scénu v rozbaľovacom zozname. 

 

Stránka správy scény v prípade niektorých modelov sa zobrazuje tak, ako je uvedené nižšie, pričom môžete 
vykonať nasledujúce kroky a nakonfigurovať scénu. 

 
1. Kliknite na položku Scenes. 

2. Vyberte scénu a potom vyberte parametre prepínania scény. Nasledujúca tabuľka obsahuje popis 
niektorých hlavných parametrov. 

Stĺpec Popis 

Current 

Označuje scénu, ktorá sa používa. 

Poznámka: 
 Ak chcete prepnúť scénu a zobraziť príslušné parametre obrazu pre scénu, vyberte 

tlačidlo možností. 
 Kamera automaticky prepína aktuálnu scénu, ak je vybratá možnosť Enable Auto 

Switching. 

Scene Name 

Názov aktuálnej scény. Zariadenie ponúka niekoľko režimov scény. Po výbere scény sa 
zobrazia príslušné parametre obrazu. Nastavenia obrazu je možné upraviť podľa aktuálnych 
potrieb. 

 Bežné: odporúčané pre scény v exteriéri. 
 Interiér: odporúčané pre scény v interiéri. 
 Vysoká citlivosť: odporúčané pre prostredie s nízkym osvetlením. 
 Kompenzácia výrazného osvetlenia: môže potlačiť silné svetlo, ako sú reflektory na 

cestách a bodové svetlá v parkoch. Odporúča sa na zachytenie značiek s evidenčnými 
číslami vozidiel. 

 WDR: odporúča sa v prípade scén s osvetlením s vysokým kontrastom, ako sú okno, 
chodba, vstupné dvere, alebo iných scén, ktoré majú svetlú vonkajšiu časť a tmavú 
vnútornú časť. 

 Vlastné: nastavenie názvu scény podľa potreby. 
 Tvár: Zachytenie tváre v pohybe v zložitých scénach. 

15 SÍEŤOVÉ TUBUSOVÉ KAMERY – POUŽÍVATEĽSKÁ PRÍRUČKA



  Copyright © NSS Sp. z o.o.

16 

Stĺpec Popis 

Auto 
Switching 

Označuje, či je potrebné pridať scénu do zoznamu automatického prepnutia. 

Poznámka: 
Ak je vybratá možnosť Auto Switching, systém automaticky prepne na scénu, keď sa splní 
podmienka prepnutia na danú scénu. Zoznam automatického prepnutia obsahuje 
predvolenú scénu. 

Setup 

Kliknutím na položku  nastavíte podmienky automatického prepnutia vrátane rozvrhu, 
osvetlenia a aktuálneho výškového uhla (uhol medzi PTZ a horizontálnym smerom). 
Znamená to, že automatické prepnutie sa spustí iba vtedy, keď osvetlenie a aktuálny 
výškový uhol počas nastaveného časového obdobia splnia nastavené podmienky. 
Podmienka je neplatná, ak sú počiatočné a koncové hodnoty nastavené na 0. 

 

3. Vyberte scénu a potom kliknite na položku , aby ste ju nastavili ako predvolenú scénu. 
4. Ak je zapnuté automatické prepnutie, kamera môže automaticky prepnúť na scénu, keď sa splní 

podmienka prepnutia na scénu, ktorá nie je predvolené. V opačnom prípade kamera ostane v režime 
predvolenej scény. Ak automatické prepnutie nie je zapnuté, kamera ostane v režime aktuálnej scény. 

 UPOZORNENIE! 
 Ak je zapnuté automatické prepnutie (nastavenia scény nebudú k dispozícii), zariadenie bude 

prepínať medzi nastavenými scénami. V opačnom prípade zariadenie ostane v režime aktuálnej 
scény. Zariadenie ostane v režime predvolených scén, až kým sa nespustia scény, ktoré nie sú 
predvolené. 

 Ak je spustených viacero scén, ktoré nie sú predvolené, zariadenie bude prepínať na scénu 
s najnižším číslom (začína od č. 1 po č. 5). 

 

Vylepšenie obrazu 

 UPOZORNENIE! 
Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho webového rozhrania.  

 

1. Kliknite na položky Setup > Image > Image a potom kliknite na položku Image Enhancement. 

 
2. Na zmenu nastavení použite jazdce. Hodnoty je možné zadať aj priamo. Nasledujúca tabuľka obsahuje 

popis niektorých hlavných parametrov. 
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Položka Popis 

Brightness 

Nastavenie stupňa jasu obrazov. 

  

Nízky jas Vysoký jas 
 

Saturation 

Stupeň odtieňa farby. 

  

Nízka sýtosť Vysoká sýtosť 
 

Contrast 

Nastavenie stupňa rozdielov medzi najtmavšími a najsvetlejšími pixelmi. 

  

Nízky kontrast Vysoký kontrast 
 

Sharpness 

Kontrast hraníc objektov v obraze. 

  

Nízka ostrosť Vysoká ostrosť 
 

2D Noise 
Reduction Zníženie šumu obrazov. Funkcia môže pôsobiť rozmazanie obrazu. 

3D Noise 
Reduction 

Zníženie šumu obrazov. Funkcia môže pôsobiť rozmazanie pohybu (alebo vytváranie 
násobných položiek v niektorých aplikáciách). 

Image 
Rotation Otáčanie obrazu.  
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Položka Popis 

  

Normálny Vertikálne preklopenie 

  

Horizontálne preklopenie 180° 

  

90° v smere pohybu  
hodinových ručičiek 

90° proti smeru pohybu  
hodinových ručičiek 

 

 

3. Ak chcete obnoviť predvolené nastavenia v tejto oblasti, kliknite na položku Default. 

Expozícia 

 UPOZORNENIE! 
 Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho 

webového rozhrania. 
 Predvolené nastavenia sa prispôsobujú scéne. Ak nie je potrebné vykonať úpravy, použite 

predvolené nastavenia. 

 

1. Kliknite na položky Setup > Image > Image a potom kliknite na položku Exposure. 
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V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne. 

 

2. Podľa potreby nastavte parametre. Nasledujúca tabuľka obsahuje popis niektorých hlavných 
parametrov. 

Parameter Popis 

Exposure 
Mode 

Výber správneho režimu expozície na dosiahnutie požadovaného efektu expozície. 

 Automatický: Kamera automaticky nastavuje expozíciu podľa prostredia. 
 Vlastné: Používateľ nastavuje expozíciu podľa potreby. 
 Interiér 50 Hz: Redukcia pásov pomocou obmedzenia frekvencie uzávierky. 
 Interiér 60Hz: Redukcia pásov pomocou obmedzenia frekvencie uzávierky. 
 Manuálne: Jemné vyladenie kvality obrazu pomocou manuálneho nastavenia uzávierky, 

zosilnenia a clony. 
 Nízky rozmazanie pohybu: Ovládanie minimálnej uzávierky na zníženie rozmazania 

pohybu v prípade tvárí zachytených v pohybe. 

Shutter (s) 

Uzávierka sa používa na reguláciu svetla prichádzajúceho do objektívu. Vysoká rýchlosť 
uzávierky je ideálna na scény s rýchlym pohybom. Malá rýchlosť uzávierky je ideálna na 
pomaly sa meniace scény. 

Poznámka: 
 Rýchlosť uzávierky môžete nastaviť, ak je položka Exposure Mode nastavená na možnosť 

Manual alebo Shutter Priority.  
 Ak je položka Slow Shutter nastavená na možnosť Off, recipročná hodnota rýchlosti 

uzávierky musí byť väčšia ako frame rate. 
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Parameter Popis 

Gain (dB) 

Ovládanie signálov obrazu tak, aby kamera vytvárala štandardné signály videa podľa 
podmienok osvetlenia. 

Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď je položka Exposure Mode nastavená na 
možnosť Manual alebo Gain Priority. 

Slow Shutter 

Zlepšuje jas obrazu pri nedostatočnom osvetlení. 

Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď položka Exposure Mode nie je nastavená 
na možnosť Shutter Priority a keď je možnosť Image Stabilizer vypnutá. 

Slowest 
Shutter 

Nastavenie najpomalšej rýchlosti uzávierky, ktorú kamera môže použiť počas expozície. 

Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď je položka Slow Shutter nastavená na 
možnosť On. 

Compensation 

Nastavenie hodnoty kompenzácie podľa potreby na dosiahnutie požadovaných efektov. 

Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď položka Exposure Mode nie je nastavená 
na možnosť Manual. 

Metering 
Control 

Nastavenie spôsobu, akým kamera meria intenzitu svetla. 

 Stredovo vážené priemerné meranie: Meranie svetla hlavne v strednej časti obrazov. 
 Hodnotiace meranie: Meranie svetla v prispôsobenej oblasti obrazov. 
 Kompenzácia výrazného osvetlenia: Ignorovanie jasu nadmerne exponovaných oblastí 

obrazov. Výberom tohto nastavenia sa však zníži celkový jas obrazu. 
 Meranie tváre: Nastavenie kvality obrazu v podmienkach slabého osvetlenia pomocou 

regulácie jasu zachytenej tváre v rámci scény tváre. 
Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď položka Exposure Mode nie je nastavená 
na možnosť Manual. 

Day/Night 
Mode 

 Automatický: Kamera vytvára optimálne obrazy podľa svetelných podmienok. V tomto 
režime môže kamery automaticky prepínať medzi nočným a denným režimom. 

 Nočný: Kamera poskytuje čiernobiele obrazy s vysokou kvalitou pomocou existujúceho 
svetla. 

 Denný: Kamera poskytuje farebné obrazy s vysokou kvalitou pomocou existujúceho 
svetla. 

Day/Night 
Sensitivity 

Prahová hodnota svetla na prepnutie medzi denným a nočným režimom. Vyššia citlivosť 
znamená, že kamera je citlivejšia na zmenu svetla a môže sa jednoduchšie prepínať medzi 
denným a nočným režimom. 

Poznámka: 
Tento parameter je možné nastaviť len vtedy, keď je položka Day/Night Mode nastavená na 
možnosť Automatic. 

Day/Night 
Switching(s) 

Nastavenie dĺžky času pred tým, než sa kamera prepne z denného na nočný režim po 
splnení podmienok prepnutia. 

Poznámka: 
Tento parameter je možné nastaviť len vtedy, keď je položka Day/Night Mode nastavená na 
možnosť Automatic. 
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Parameter Popis 

WDR 

Zapnutie WDR na rozlíšenie svetlých a tmavých oblastí v tom istom obraze. 

Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď položka Exposure Mode nie je nastavená 
na možnosť Customize ani na možnosť Manual a keď je možnosť Image Stabilizer je 
vypnutá. 

WDR Level 

Po zapnutí funkcie WDR môžete vylepšiť obraz nastavením úrovne WDR. 

Poznámka:  
V prípade výskytu vysokého kontrastu medzi svetlými a tmavými oblasťami scény použite 
úroveň 7 alebo vyššiu. V prípade nízkeho kontrastu sa odporúča vypnúť WDR alebo použiť 
úroveň 1 až 6. 

Suppress WDR 
Stripes 

Ak je to zapnuté, kamera môže automaticky nastaviť frekvenciu pomalej uzávierky podľa 
frekvencie svetla na minimalizáciu pásov, ktoré by sa mohli objaviť na obrazoch. 

 

3. Ak chcete obnoviť predvolené nastavenia, kliknite na položku Default. 

Inteligentné nasvietenie 

 UPOZORNENIE! 
Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho webového rozhrania.  

 

1. Kliknite na položky Setup > Image > Image a potom kliknite na položku Smart Illumination. 

 

2. Vyberte správny IR riadiaci režim a nastavte parametre. Nasledujúca tabuľka obsahuje popis 
niektorých hlavných parametrov. 

Parameter  Popis  

Lighting Type 

 Infračervené: Kamera používa osvetlenie infračerveného svetla. 
 Biele svetlo: Kamera používa osvetlenie bielym svetlom. 
Poznámka: 
Keď je položka Control Mode nastavená na možnosť Manual, kamera môže nastaviť úroveň 
osvetlenia od 0 do 1000. 

Control Mode 

 Globálny režim: Kamera nastavuje osvetlenie IR a expozíciu na dosiahnutie vyvážených 
efektov obrazov. Ak vyberiete túto možnosť, niektoré oblasti môžu byť nadmerne 
exponované. Táto možnosť sa odporúča, ak je vašou najvyššou prioritou monitorovaný 
rozsah a jas obrazu. 

 Potlačenie nadmernej expozície: Kamera nastavuje osvetlenie IR a expozíciu, aby sa 
zabránilo nadmernej expozícii oblastí. Ak vyberiete túto možnosť, niektoré oblasti môžu 
byť tmavé. Táto možnosť sa odporúča, ak je vašou najvyššou prioritou jasnosť stredovej 
časti obrazu a regulácia nadmernej expozície. 

 Cesta: Tento režim umožňuje celkové výrazné osvetlenie a odporúča sa na 
monitorovanie scén so širokým rozsahom, napr. ciest. 

 Park: Tento režim umožňuje jednotné svetlo a odporúča sa na monitorovanie scén 
s malým rozsahom a viacerými prekážkami, napr. priemyselných parkov. 

 Manuálne: Tento režim umožňuje manuálne ovládanie intenzity IR osvetlenia. 
 Interiér: Tento režim sa odporúča v prípade použitia pri scénach v interiéri. 
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Parameter  Popis  

Illumination 
Level 

Nastavenie úrovne intenzity IR svetla. Čím je hodnota vyššia, tým je vyššia intenzita.  
0 znamená, že je IR svetlo vypnuté. 

 Úroveň osvetlenia nablízko: Tento parameter odporúčame nastaviť predovšetkým 
v prípade širokouhlých scén. 

 Stredná úroveň osvetlenia: Tento parameter odporúčame nastaviť predovšetkým 
v prípade, ak scéna vyžaduje strednú dĺžku zaostrenia. 

 Úroveň osvetlenia naďaleko: Tento parameter odporúčame nastaviť predovšetkým 
v prípade, ak scéna vyžaduje zobrazenie teleobjektívom. 

Poznámka: 
Tento parameter je možné nastaviť len vtedy, keď je položka Control Mode nastavená na 
možnosť Manual. 

 

3. Ak chcete obnoviť predvolené nastavenia, kliknite na položku Default. 

Zaostrenie  

 UPOZORNENIE! 
Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v popisoch aktuálnych modelov.  

 

1. Kliknite na položky Setup > Image > Image a potom kliknite na položku Focus. 

 

2. Podľa potreby nastavte zaostrenie. 

Parameter Popis 

Focus Mode 

 Automatické zaostrenie: Kamera automaticky zaostruje podľa aktuálnych svetelných 
podmienok. 

 Manuálne zaostrenie: Podľa potreby nastavte zaostrenie kamery. 
 Zaostrenie jedným kliknutím: Zaostrenie kamery sa spúšťa pri otáčaní, približovaní alebo 

prechádzaní na predvoľbu. 
 Zaostrenie jedným kliknutím (IR): Pri podmienkach so slabým svetlom, napr. počas noci 

alebo v tmavom dome, sa pomocou tohto režimu zaostrenia dosiahne lepší efekt, ak je 
zapnuté IR svetlo. 

Scene 

 Normálna: Používa sa v prípade bežných scén, ako sú cesta a priemyselný park. 
 Veľká vzdialenosť: Používa sa v prípade monitorovania veľkej vzdialenosti na ceste. 

Napríklad, ak je kamera nainštalovaná vo výške viac ako 30 metrov na monitorovanie 
vzdialenej križovatky ciest. 

 

3. Ak chcete obnoviť predvolené nastavenia, kliknite na položku Default. 

Vyváženie bielej 

Vyváženie bielej je postup vyrovnávajúci neprirodzený farebný odtieň v obrazoch pri rôznych teplotách 
farieb, aby sa získali obrazy, ktoré najlepšie vyhovujú ľudskému zraku. 

 UPOZORNENIE! 
Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 
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1. Kliknite na položky Setup > Image > Image a potom kliknite na položku White Balance. 

 
2. Podľa potreby nastavte režim vyváženia bielej. Nasledujúca tabuľka obsahuje popis niektorých 

hlavných parametrov. 

Parameter Popis 

White Balance 

Nastavenie kompenzácie červenej alebo modrej farby obrazu: 

 Automatický/Automatický 2: Kamera automaticky nastavuje červený a modrý posun 
podľa svetelných podmienok (farba má tendenciu byť modrá). Ak sú v automatickom 
režime obrazy stále neprirodzene červené alebo modré, vyskúšajte automatický režim 2. 

 Jemné doladenie: Umožňuje manuálne nastaviť červený a modrý posun. 
 Exteriér: Vhodné v prípade vonkajších prostredí s relatívne veľkým teplotným rozsahom. 
 Zaistené: Zaistenie aktuálneho teplotného rozsahu bez zmeny. 
 Sodíková lampa: Kamera automaticky nastavuje červený a modrý posun podľa 

svetelných podmienok (farba má tendenciu byť červená). 

Red Offset 

Manuálne nastavenie kompenzácie červenej farby. 

Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď je položka White Balance nastavená na 
možnosť Fine Tune. 

Blue Offset 

Manuálne nastavenie kompenzácie modrej farby. 

Poznámka: 
Tento parameter je možné nastaviť len vtedy, keď je položka White Balance nastavená na 
možnosť Fine Tune. 

 

3. Ak chcete obnoviť predvolené nastavenia, kliknite na položku Default. 

Rozšírené 

Funkciu odhmlievania používajte na nastavenie jasnosti obrazov zachytených v hmle alebo pare. 

1. Kliknite na položky Setup > Image > Image a potom kliknite na položku Advanced. 

 

 UPOZORNENIE! 
 Tento parameter je možné nastaviť, iba keď je WDR vypnuté. 
 Optické odhmlievanie podporujú iba niektoré modely kamier. Keď je položka Defog nastavená na 

možnosť On, úroveň intenzity odhmlievania 6 – 9 predstavuje optické odhmlievanie a obrazy sa 
menia z farebných na čiernobiele, keď sa intenzita odhmlievania nastaví z úrovne 5 na úroveň 6; ak 
je položka Defog nastavená na možnosť Auto a úroveň intenzity odhmlievania sa nachádza medzi 
hodnotami 6 – 9, obrazy sa automaticky nemenia na čiernobiele pri slabých hmlistých 
podmienkach; kamera automaticky prepne na optické odhmlievanie iba v prípade výrazných 
hmlistých podmienok. 
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2. Zapnite funkciu odhmlievania a potom vyberte úroveň danej scény. Pomocou úrovne 9 sa dosiahne 
maximálny efekt odhmlievania a pomocou úrovne 1 sa dosiahne minimálny efekt odhmlievania. 

  
Vypnuté odhmlievanie Zapnuté odhmlievanie 

 

3. Ak chcete obnoviť predvolené nastavenia, kliknite na položku Default. 

Typ osvetlenia 

 UPOZORNENIE! 
Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v popise aktuálneho modelu.  

 

1. Kliknite na položky Setup > Image > Image a potom kliknite na položku Smart Illumination 

 

2. Vyberte možnosť z rozbaľovacieho zoznamu Lighting Type. 

3. Ak chcete obnoviť predvolené nastavenia, kliknite na položku Default. 

Konfigurácia režimu clony a objektívu 

 UPOZORNENIE! 
 Túto funkciu podporujú iba niektoré typy sieťových skrinkových kamier. Podrobnosti nájdete 

v popise aktuálneho modelu. 
 Objektív používate iba v riadiacom režime P-clony a pripojte ovládací kábel clony k portu 

Z/F kamery. 
 Clonu je možné nastaviť len vtedy, keď je položka Lens Mode nastavená na možnosť P-IRIS. 

 

1. Kliknite na položky Setup > Image > Image a potom kliknite na položku Advanced. 

 

2. Podľa potreby upravte nastavenia. Nasledujúca tabuľka obsahuje popis niektorých hlavných 
parametrov. 
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Parameter Popis 

Lens Mode 
 Z/F: úprava zaostrenia a priblíženia. 
 P-clona: úprava hodnoty clony. 

Aperture 
Control 

Automatické alebo manuálne nastavenie clony. 
Poznámka:  
Tento parameter je možné nastaviť len vtedy, keď je položka Lens Mode nastavená na 
možnosť P-Iris. 

F-Number Manuálna zmena clony. 

 

3. Ak chcete obnoviť predvolené nastavenia, kliknite na položku Default. 

Nastavenie OSD 

Zobrazenie na obrazovke (OSD) je text zobrazený na obrazovke s obrazmi videa a môže obsahovať čas a iný 
prispôsobený obsah. 

 UPOZORNENIE! 
Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 

 

1. Kliknite na položky Setup > Image > OSD. 

 

Rozhranie OSD niektorých modelov sa zobrazuje nasledovne. 
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2. Vyberte polohu a obsah OSD. 

 Poloha: Kliknite na požadované políčko v oblasti Live View. Po zmene tvaru kurzora kliknite a podržte 
tlačidlo na presun políčka do požadovanej polohy. Ak chcete nastaviť polohu presne, použite súradnice 
X a Y pod časťou Overlay Area. 

 Overlay OSD Content: V rozbaľovacom zozname sa nachádzajú položky Time, Preset a Serial Info. 
Môžete vybrať aj položku Custom a zadať ľubovoľný obsah. 

 Po nastavení polohy a obsahu OSD sa v stĺpci Status zobrazí symbol , ktorý označuje, že OSD sa 
úspešne nastavilo. Môžete nastaviť viacero riadkov obsahu pre každú oblasť a na nastavenie poradia 
zobrazenia môžete použiť  a . 

3. Po dokončení nastavení sa zobrazí hlásenie s označením úspešného nastavenia. 

V okne ukážky môžete kliknúť pravým tlačidlom a potom zvoliť zobrazenie v režime celej obrazovky alebo 
v určitom pomere strán. Dvojitým kliknutím v okne ukážky môžete aj prejsť alebo ukončiť režim celej 
obrazovky. 

Ak chcete zrušiť OSD oblasti, vymažte obsah OSD v stĺpci Overlay OSD Content alebo vyberte položku None 
v stĺpci Position. 

Nasledujúca časť zobrazuje príklad OSD času. 
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Vymaskovanie privátnych zón 

V určitých situáciách budete pravdepodobne potrebovať nastaviť oblasť masky na obraze kamery na 
ochranu osobných údajov, napr. klávesnicu prístroja ATM. Ak sa zmení poloha alebo priblíženie PTZ, 
vymaskovanie privátnych zón sa príslušne nastaví, aby sa po celý čas oblasť ochránila. 

 UPOZORNENIE! 
Táto funkcia sa môže líšiť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho webového rozhrania.  

 

1. Kliknite na položky Setup > Image > Privacy Mask. 

 
V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne: 
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2. Kliknutím na položku  pridáte vymaskovanie privátnych zón a kliknutím na položku  odstránite 
masku. 

 Maskovanie polohy: Začiarknutím políčka ( zobrazuje sa v ňom položka Mask) aktivujete masku. Po 
zmene tvaru kurzora potiahnite políčko do určenej polohy. 

 Maskovanie oblasti: Pomocou myší zakreslite políčko v oblasti, ktorú chcete maskovať. 

Po konfigurácii vymaskovania privátnych zón sa určené oblasť uzamkne. Nižšie je uvedený príklad. 

 

Konfigurácia zvuku a videa 

Konfigurácia videa 

Môžete nastaviť parametre, ktoré podporuje kamera a zobraziť aktuálny stav výstupu BNC. Ak je to 
dostupné, podľa potreby môžete zapnúť aj vedľajší stream a tretí stream. 

 

UPOZORNENIE! 
 Táto funkcia sa môže líšiť v závislosti od modelu. Tretí stream podporujú iba niektoré modely kamier. 

Informácie o tom, či vaša kamera podporuje túto funkciu, nájdete v rámci webového rozhrania. 
 Po zapnutí vedľajšieho alebo tretieho streamu upravte parametre podľa potreby. Parametre vedľajšieho 

a tretieho streamu majú rovnaký význam ako parametre hlavného streamu. 
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1. Kliknite na položky Setup > Video & Audio > Video. 

 

2. Podľa potreby upravte nastavenia. Nasledujúca tabuľka obsahuje popis niektorých hlavných 
parametrov. 

Parameter Popis 

Video 
Compression 

Tri možnosti: H.265, H.264 a MJPEG. 
Poznámka: 

 Kvalitu obrazu nie je možné nastaviť, ak je kompresia videa nastavená na H.265 alebo 
H.264. V prípade nastavenia na MJPEG sú k dispozícii tri frame rate: 1, 3 a 5; nastaviť 
nie je možné položky bitová rýchlosť, interval snímok I, vyhladenie a U-kód. 

 Bitová rýchlosť sa zmení na predvolenú, ak zmeníte nastavenie na hodnoty medzi 
H.264 a H.265. Predvolená bitová rýchlosť pre H.265 je polovica hodnoty pre H.264. 

Frame Rate 

Frame rate kódovacie obrazy. Jednotka: FPS (snímka za sekundu). 

Poznámka: 
Kvôli zabezpečeniu kvality obrazu upozorňujeme, že frame rate musí mať vyššiu hodnotu 
ako je recipročná rýchlosť alebo rýchlosť uzávierky. 

Bitrate Type 

 CBR: Konštantná bitová rýchlosť, čo znamená, že kamera prenáša údaje pri 
konštantnej rýchlosti údajov. 

 VBR: Variabilná bitová rýchlosť, čo znamená, že kamera dynamicky nastaví bitovú 
rýchlosť podľa kvality obrazu. 

Image Quality 

Keď je položka Encoding Mode nastavená ako VBR, môžete posunúť jazdec, aby ste 
nastavili úroveň kvality obrazov. Posunutím jazdca smerom k položke Bit Rate znížite 
bitovú rýchlosť a môžete ovplyvniť kvalitu obrazu. Posunutím jazdca smerom k položke 
Quality zvýšite bitovú rýchlosť a zlepšíte kvalitu obrazu. 

I Frame Interval Interval, pri ktorom sa kóduje snímka I. Kratší interval snímok I zvyčajne poskytuje lepšiu 
kvalitu obrazu, ale spotrebúva väčšiu šírku pásma. 

GOP Skupina obrázkov v rámci kódovania videa MPEG. Tento parameter špecifikuje poradie, 
v ktorom sa intra-snímky (snímka I) a inter-snímky zoradia. 
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Parameter Popis 

SVC Pomocou SVC (prispôsobiteľné kódovanie videa) sa môže zredukovať úložisko bez 
ovplyvnenia kvality prehrávania. 

U-Code 

 Základný režim: Skutočná bitová rýchlosť tvorí asi 3/4 nastavenej bitovej rýchlosti. 
 Rozšírený režim: Skutočná bitová rýchlosť tvorí asi 1/2 nastavenej bitovej rýchlosti. 
Poznámka: 
 Keď ja zapnutá možnosť U-kódu, kompresia videa podporuje iba H.264 a H.265. MJPEG 

sa nepodporuje. 
 Keď ja zapnutá možnosť U-kódu, režim záznamu nepodporuje frame rate vyššie ako 30. 

Smoothing 

Nastavenie rozsahu vyhladenia. Výber položky Clear znamená vypnutie položky 
Smoothing. Posunutím jazdca smerom k položke Smooth zvýšite úroveň vyhladenia, ale 
ovplyvní to kvalitu obrazu. 

Poznámka:  
V prostredí so slabým pripojením k sieti môžete zapnúť vyhladenie a získať tak plynulejšie 
video. 

BNC Output Výstup BNC podporuje NTSC a PAL. 

 

3. Kliknite na položku Save. 

Konfigurácia zvuku 

Konfigurácia zvuku znamená nastavenie parametrov kódovania kamery. 

 

UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Setup > Video & Audio > Audio. 

 
2. Podľa potreby upravte nastavenia. Nasledujúca tabuľka obsahuje popis niektorých hlavných 

parametrov. 

Parameter Popis 

Audio Input 

Po výbere položky Off nebude možné kódovať žiadne údaje zvuku. 

Poznámka:  
Položku Off odporúčame vybrať, ak nepotrebujete zvuk. Môže to do určitej miery zlepšiť 
výkon zariadenia. 
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Parameter Popis 

Access Mode 

Aktuálne iba vedenie/mikrofón. 

Poznámka:  

Táto funkcia nie je k dispozícii v prípade zariadení s dvomi kanálmi zvukového výstupu. 

Audio 
Compression 

Tri možnosti: G.711U, G.711A a ACC-LC.  

Možnosti G.711U a G.711A podporujú iba samplovaciu rýchlosť 8K a možnosť ACC-LC 
podporuje samplovacie rýchlosti 8K, 16K a 48K. 

Input Gain Zosilnenie zvukového signálu na samplovanie. Čím je zosilnenie vyššie, tým je vyššia 
amplifikácia. 

Noise 
Suppression 

Používa sa na redukciu šumu na obrazoch. Ak chcete zapnúť potlačenie šumu, vyberte 
položku On. 

Channel 

Kanál zvukového výstupu. Ak chcete zapnúť zvukový výstup, vyberte položku Enable. 

Poznámka:  

Iba niektoré modely kamier podporujú dva kanály. 

 

3. Kliknite na položku Save. 

Snímka 

1. Kliknite na položky Setup > Video & Audio > Snapshot. 

 
2. Vyberte položku On a potom podľa potreby nastavte rozlíšenie, kvalitu obrazu a rozvrh. 

3. Kliknite na položku Save. 

Oblasť záujmu 

Keď je zapnutá oblasť záujmu (ROI), systém najprv zaručí kvalitu obrazu, ak je bitová rýchlosť nedostatočná. 

 

UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Setup > Video & Audio > ROI. 
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2. Kliknite na položku  a potom posuňte myš tak, aby ste pokryli určenú časť obrazov. Na odstránenie 

vyberte oblasť a potom kliknite na položku . 

Konfigurácia mediálneho streamu 

Mediálny stream 

Vytvorené mediálne streamy z kamery je možné zobraziť. Je možné aj nastaviť kameru tak, aby prenášala 
streamy kódov pomocou protokolu UDP alebo TCP na špecifikovanú adresu IP a číslo portu. Nastavenie je 
možné uložiť, pričom môže nadobudnúť platnosť po reštartovaní kamery. 

 

UPOZORNENIE! 
 Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 
 Výber transportného protokolu na základe skutočných potrieb a výkonu siete. Všeobecne 

povedané, TCP umožňuje lepšiu kvalitu obrazu ako UDP, ale tiež spôsobuje vyššie oneskorenie. 

 

1. Kliknite na položky Setup > Video & Audio > Media Stream. 

 

2. Kliknite na položku , vyberte typ streamu a potom nastavte adresu IP a číslo portu skupiny 

jednosmerového vysielania alebo rozosielania pre dekódovacie zariadenie, ktoré prijíma streamy 
zvuku a videa z kamery. 
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Ak chcete, aby zariadenie vytvorilo mediálny stream, ktorý sa predtým automaticky nakonfiguroval po 
reštarte, vyberte položku Yes alebo Persistent. 

3. Ak chcete odstrániť stream, kliknite na položku . 
4. Kliknutím na položku Submit dokončíte operácie. 

Adresa rozosielania RTSP  

Po konfigurácii adresy rozosielania RTSP môže prehrávač tretej strany vyžiadať mediálny stream rozosielania 
RTSP z kamery prostredníctvom protokolu RTP. 

1. Kliknite na položky Setup > Video & Audio > Media Stream > RTSP Multicast Address. 

 
V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne. 
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2. Nastavte adresu rozosielania (224.0.0.0 až 239.255.255.255) a číslo portu (0 až 65535). 

3. Kliknite na položku Save. 

Konfigurácia inteligentného alarmu 
Je možné nakonfigurovať inteligentné monitorovania na počítanie ľudí a monitorovať objekty v pohybe. 
Inteligentné monitorovanie zahŕňa počítanie ľudí, detekciu neoprávneného vniknutia a automatické 
sledovanie. 

Podporované funkcie sa môžu líšiť v závislosti od modelu kamery. 

Inteligentné nastavenia 

Kliknite na položky Setup > Intelligent > Smart Settings. 

 
V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne. 
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Detekcia prekročenia línie 

Pomocou detekcie prekročenia línie sa detegujú objekty, ktoré prekročia virtuálnu líniu v živom videu, 
pričom pri detekcii takejto udalosti sa spúšťa alarm. 

1. Kliknite na položky Setup > Intelligent > Smart Settings. Zvoľte položku Cross Line a potom kliknite na 

položku . 

 

 

2. Vyberte položku Cross Line Detection. 

3. V oblasti Detection Rule kliknite na položku , aby ste pridali novú oblasť detekcie. Ak chcete 

odstrániť oblasť, kliknite na položku . 
4. V malom okne ukážky posuňte líniu do určenej polohy a nastavte rozsah detekcie. 

5. Nastavte smer a citlivosť kamery na rozhodnutie o tom, či hlásiť alarm detekcie prekročenia línie. 

6. Podľa potreby nastavte činnosti spustené alarmom a rozpis aktivácie. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

7. Kliknite na položku Save. 

Detekcia neoprávneného vniknutia 

Pomocou detekcie neoprávneného vniknutia sa detegujú objekty, ktoré vstúpia do určitej oblasti v živom 
videu, pričom pri detekcii takejto udalosti sa spúšťa alarm. 

1. Kliknite na položky Setup > Intelligent > Smart Settings. Zvoľte položku Intrusion a potom kliknite na 

položku . 
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2. Vyberte položku Intrusion Detection. 

3. V oblasti Detection Rule kliknite na položku , aby ste pridali novú oblasť detekcie. Ak chcete 

odstrániť oblasť, kliknite na položku . 
4. Posuňte hranice poľa tak, aby ste nastavili určený polohu a rozsah. 

5. Nastavte prahovú hodnotu času, citlivosť a percento kamery na rozhodnutie o tom, či hlásiť alarm 
detekcie neoprávneného vniknutia. 

 Time Threshold: Minimálna dĺžka časového obdobia, počas ktorej rušivý prvok zotrvá v oblasti 
detekcie pred hlásením alarmu. 

 Sensitivity: Citlivosť detekcie. Najväčšia hodnota znamená najvyššiu citlivosť detekcie. 

 Percentage: Minimálny pomer veľkosti rušivého prvku a veľkosti určitej oblasti detekcie pred hlásením 
alarmu. 

6. Podľa potreby nastavte činnosti spustené alarmom a rozpis aktivácie. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

7. Kliknite na položku Save. 

Detekcia tváre 

Pomocou detekcie tváre sa detegujú tváre ľudí v živom videu. 

1. Kliknite na položky Setup > Intelligent > Smart Settings. Zvoľte položku Face a potom kliknite na 

položku . 
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2. Posuňte hranice tak, aby ste nastavili určený polohu a rozsah. 

3. Nastavte parametre detekcie podľa aktuálnych potrieb. 

4. Podľa potreby nastavte činnosti spustené alarmom a rozpis aktivácie. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

5. Kliknite na položku Save. 

6. Kliknite na položku Start Intelligent Analysis. 

Počítanie ľudí 

 

UPOZORNENIE! 
 Túto funkciu podporujú iba niektoré modely kamier. 
 Podporované spustenie alarmu a aktivácia rozvrhu sa môžu líšiť v závislosti od modelu kamery. 

Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 

 

1. Kliknite na položky Setup > Intelligent > Smart Settings. Zvoľte položku People Counting a potom 

kliknite na položku . 
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2. Vyberte položku Enable Passenger Flow Detection. Vyberte režim detekcie, nastavte interval 

a citlivosť hlásenia. 

3. Kliknite na položku Draw Detection Area a potom v okne ukážky na ľavej strane zakreslite oblasť 
detekcie, napr. štvorec. 

4. Kliknite na položku Draw Entrance Direction a potom v okne ukážky na ľavej strane zakreslite smer. 
Smer je zvyčajne vertikálny alebo šikmý. 

5. Nastavte Max. Size a Min. Size v časti Filter by Object Size. Započítavať sa budú iba objekty v rámci 
rozsah veľkosti; ostatné sa vyfiltrujú a nezapočítajú sa. 

6. Podľa potreby nastavte činnosti spustené alarmom a rozpis aktivácie. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

7. Ak chcete resetovať výsledky počítania, kliknite na položku Clear Counting Result. 

8. Kliknite na položku Save. 

Automatické sledovanie 

Kamera automaticky sleduje objekt, ktorý spustil pravidlo. 

 

UPOZORNENIE! 
 Túto funkciu podporujú iba niektoré modely kamier. 
 Podporované spustenie alarmu a aktivácia rozvrhu sa môžu líšiť v závislosti od modelu kamery. 

Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 

 

1. Kliknite na položky Setup > Intelligent > Smart Settings. Zvoľte položku Auto Tracking a potom kliknite 

na položku . 
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2. Nastavte časový limit sledovania (jednotka: s) a pomer priblíženia. 

3. Kliknite na položku Save. 

Detekcia rozostrenia 

 

UPOZORNENIE! 
 Túto funkciu podporujú iba niektoré modely kamier. 
 Podporované spustenie alarmu a aktivácia rozvrhu sa môžu líšiť v závislosti od modelu kamery. 

Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 

 

Detekcie rozostrenia používajte na detekciu rozostrenia kamery a na hlásenie alarmu v prípade detekcie 
takejto udalosti. 

1. Kliknite na položky Setup > Intelligent > Smart Settings. Zvoľte položku Defocus a potom kliknite na 

položku . 

 

2. Vyberte položku Defocus Detection. 

3. Podľa potreby nastavte citlivosť detekcie a činnosti spustené alarmom. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

4. Kliknite na položku Save. 
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Detekcia zmeny scény 

 

UPOZORNENIE! 
 Túto funkciu podporujú iba niektoré modely kamier. 
 Podporované spustenie alarmu a aktivácia rozvrhu sa môžu líšiť v závislosti od modelu kamery. 

Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 

 

Detekciu zmeny scény používajte na detekciu zmeny prostredia sledovania spôsobenú externými faktormi, 
ako sú zámerné otočenie kamery a na hlásenie alarmu pri detekcii takejto udalosti. 

1. Kliknite na položky Setup > Intelligent > Smart Settings. Zvoľte položku Scene Change a potom kliknite 

na položku . 

 
2. Vyberte položku Scene Change Detection. 

3. Nastavte citlivosť detekcie. Podľa potreby nastavte činnosti spustené alarmom a rozpis aktivácie. 
Podrobné kroky nájdete v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie 
pohybu. 

4. Kliknite na položku Save. 

Rozšírené nastavenia 

Rozšírené nastavenia zahŕňajú jasnosť snímky a režim detekcie pre inteligentné funkcie. 

Parametre fotografií 

Nastavte jasnosť snímok. 

1. Kliknite na položky Setup > Intelligent > Advanced Settings. Kliknite na kartu Photo parameters . 
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2. Nastavte jasnosť pôvodného obrazu a obrazu miniatúry. 

3. Kliknite na položku Save. 

 

UPOZORNENIE! 
Pred nastavením parametre fotografií vypnite detekciu tváre. 

 

Parametre detekcie 

 

UPOZORNENIE! 
 Rozšírené nastavenia podporujú iba niektoré modely kamier. Podrobnosti nájdete v rámci 

aktuálneho webového rozhrania. 
 Predvolený režim detekcie je Normal Mode. Nastavte ho podľa potreby. 

 

1. Kliknite na položky Setup > Intelligent > Advanced Settings. Kliknite na kartu Detection parameters. 

 

2. Zvoľte režim detekcie. Zvoľte položku Filter Repeated Motion Mode, ak chcete zabrániť opakovanému 
hláseniu alarmu spôsobenému detekciou pohybu v prostredí sledovania. 

3. Kliknite na položku Save. 

Konfigurácia bežného alarmu 
Môžete naplánovať hlásenie alarmu a nastaviť činnosti, ktoré môžu spustiť ďalšie zariadenia tak, aby sa 
alarmy a spustené činnosti spracovávali načas. 

Hlásenie alarmu je možné naplánovať pre alarm detekcie pohybu, vstup alarmu, výstup alarmu, alarm 
detekcie cudzieho zásahu a alarm detekcie zvuku. Podporované alarmy sa môžu líšiť v závislosti od modelu 
zariadenia. Informácie o typoch alarmu, ktoré kamera podporuje, nájdete v rámci webového rozhrania. 

Konfigurácia alarmu detekcie pohybu 

Pomocou detekcie pohybu sa deteguje pohyb objektu v určitej obdĺžnikovej oblasti počas daného obdobia. 
Je potrebné nastaviť oblasť detekcie, citlivosť detekcie, veľkosť objektu a históriu kamery na rozhodnutie 
o tom, či hlásiť alarm detekcie pohybu v prípade detekcie pohybu. 

 

UPOZORNENIE! 
 Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 
 Činnosti spustené alarmom sa môžu meniť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho 

webového rozhrania. 

 

Detekcia oblasti 

1. Kliknite na položky Setup > Events > Common Alarm > Motion Detection. Nastavte položku Detection 
Mode na možnosť Area. 
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2. V oblasti Detection Area kliknite na položku , aby ste pridali novú oblasť detekcie. Ak chcete 

odstrániť oblasť, kliknite na položku . 
3. Kliknite a posuňte myš, aby ste nastavili oblasť detekcie. 

4. Nastavte citlivosť detekcie, veľkosť objektu a históriu kamery na rozhodnutie o tom, či hlásiť alarm 
detekcie pohybu. 

 Citlivosť detekcie sa zvyšuje posunom jazdca doprava. Ak rozsah pohybu v oblasti detekcie prekročí 
nastavenú veľkosť objektu a ak trvanie pohybu prekročí nastavenú dĺžku trvania, kamera nahlási 
alarm. 

 Veľkosť objektu určuje minimálny pomer veľkosti objektu a veľkosti celkovej oblasti detekcie pred 
hlásením alarmu. To znamená, že na detekciu pohybu malých objektov musíte príslušne zakresliť malé 
pole (oblasť detekcie) v aktuálnej oblasti pohybu. 

 Výsledky detekcie pohybu sa zobrazujú v reálnom čase. Červené čiary predstavujú alarmy zvýšenej 
detekcie pohybu. Čím dlhšia je čiara, tým väčší je rozsah pohybu. Čím sú čiary hustejšie, tým väčšia je 
frekvencia pohybu. 

 
 

5. Nastavte parametre alarmu. 

 Potlačenie alarmu(-ov): Po spustení alarmu sa počas nastaveného času nebude hlásiť rovnaký alarm. 

 Vymazanie alarmu(-ov): Po spustení alarmu 

a. Ak sa rovnaký alarm nespustí počas nastaveného času, alarm sa vymaže a rovnaký alarm sa môže 
opäť hlásiť. 
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b. Ak sa rovnaký alarm spustí počas nastaveného času, alarm sa nevymaže, až kým nevyprší čas 
potlačenia alarmu. Potom sa rovnaký alarm môže opäť hlásiť. 

6. Nastavte činnosti, ktoré sa majú spustiť alarmom detekcie pohybu, a plán. 

 

Nasledujúca tabuľka obsahuje popis hlavných činností, ktoré spúšťa alarm, a spôsob nastavenia plánu. 

Položka Popis 

Alarm 
Output 1 

Začiarknite políčko. Toto nastavenie sa týka rozhrania výstupu alarmu prepojeného na alarm 
detekcie pohybu. 

Poznámka:  
Po hlásení alarmu kamera spustí výstup alarmu tak, aby sa spustili činnosti zariadenia tretej 
strany. 

Goto 
Preset 

Začiarknite políčko a nastavte predvoľbu prepojenú na alarmu detekcie pohybu. 

Poznámka: 
 Uistite sa, že ste nastavili predvoľby. V opačnom prípade nie je možné nastaviť tento 

parameter. Podrobnosti o spôsobe nastavenie predvoľby nájdete v časti Nastavenie 
predvolieb. 

 Po hlásení alarmu kamera PTZ automaticky prejde na predvoľbu, aby zachytila video v rámci 
správnej scény. 

Upload to 
FTP 

Ak je vybratá možnosť Upload to FTP, kamera bude po spustení alarmu automaticky nahrávať 
snímky na určený server FTP. 

Poznámka: 
Pred použitím tejto funkcie sa uistite, že ste dokončili kroky v časti FTP a Snímka. 

Recording 

Ak je vybratá možnosť Recording, kamera bude po spustení alarmu automaticky nahrávať video. 

Poznámka: 

Najprv nastavte položku Post-Record(s) na stránke Storage. Položka Post-Record(s) určuje, ako 
dlho po skončené alarmu bude nahrávanie pokračovať. 

Alarm the 
Center 

Ak je vybratá možnosť Alarm the Center, kamera bude po spustení alarmu odosielať informácie 
o alarme do centrálneho servera. 

Poznámka: 

Najprv dokončite nastavenia na stránke Server. 

Trigger 
Tracking 

Ak je vybratá možnosť Trigger Tracking, kamera po spustení alarmu spustí automatické 
sledovanie. 

Poznámka: 

Túto funkciu podporujú iba niektoré modely kamier. 

Najprv nastavte automatické sledovanie na stránke Smart Settings. 

Trigger 
E-mail 

Ak je vybratá možnosť Trigger E-mail kamera bude po spustení alarmu odosielať snímky na 
určenú e-mailovú adresu. 

Poznámka: 
Pred použitím tejto funkcie sa uistite, že ste dokončili kroky v časti E-Mail. 
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Enable Plan 

Začiarknite políčko a nastavte počiatočný a koncový čas, v rámci ktorých bude aktívny alarm 
detekcie pohybu. Ak chcete upraviť časové obdobia v tabuľke, môžete priamo potiahnuť myš 
a zakresliť plán a kliknúť na položku Edit. Časové obdobia sa nesmú prekrývať. Kamera hlási 
alarmy iba počas určeného obdobia (období). 

Je možné vybrať pondelok až nedeľu a nastaviť štyri obdobia pre každý deň. 

 

 

Potiahnutie myšou a zakreslenie plánu  Úprava časových období v tabuľke 

Poznámka:  
Zakreslenie plánu pomocou myši podporujú iba verzie IE staršie ako 8.0. Po nastavení plánu 
jedného dňa je možné použiť rovnaké nastavenie aj v prípade ostatných dní kliknutím na položky 
Copy a Paste. 

 

7. Kliknite na položku Save. 

Detekcia pomocou mriežky 

1. Kliknite na položky Setup > Events > Motion Detection. Nastavte položku Detection Mode na možnosť 
Grid. 

 
2. Oblasť (oblasti) detekcie môžu byť na mriežke nepravidelné. 

3. Nastavte citlivosť detekcie kamery na rozhodnutie o tom, či hlásiť alarm detekcie pohybu (alarm 
viditeľný na kompatibilnom NVR). 

4. Nastavte parametre alarmu. 

 Suppress Alarm(s): Po spustení alarmu sa počas nastaveného času nebude hlásiť rovnaký alarm. 

 Clear Alarm(s): Po spustení alarmu 

a. Ak sa rovnaký alarm nespustí počas nastaveného času, alarm sa vymaže a rovnaký alarm sa môže 
opäť hlásiť. 
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b. Ak sa rovnaký alarm spustí počas nastaveného času, alarm sa nevymaže, až kým nevyprší čas 
potlačenia alarmu. Potom sa rovnaký alarm môže opäť hlásiť. 

5. Nastavte činnosti, ktoré sa majú spustiť alarmom detekcie pohybu, a plán. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Detekcia oblasti v časti Konfigurácia alarmu detekcie 
pohybu. 

6. Kliknite na položku Save. 

Konfigurácia alarmu cudzieho zásahu 

Nakonfigurujte alarm cudzieho zásahu, aby kamera hlásila alarm, keď je objektív zablokovaný na určitú 
dobu. 

 

UPOZORNENIE! 
 Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 
 Činnosti spustené alarmom sa môžu meniť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho 

webového rozhrania. 

 

1. Kliknite na položky Setup > Events > Common Alarm >Tampering Alarm. 

 

2. Nastavte možnosť On pre položku Tampering Alarm. 

3. Nastavte citlivosť detekcie a trvanie kamery na rozhodnutie o tom, či hlásiť alarm cudzieho zásahu. 

Citlivosť je rozdelená na tri úrovne: vysoká, stredná a nízka úroveň. Keď je citlivosť nastavená na 
vysokú, kamera dokáže detegovať blokovanie na vzdialenejšom mieste v porovnaní s citlivosťou 
strednej úrovne. Kamera hlási alarm, keď je objektív zablokovaný na určitú dobu. 

Alarm cudzieho zásahu je aktívny na celej obrazovke. Ak chcete alarm cudzieho zásahu vypnúť, zrušte 
začiarknutie políčka Tampering Alarm. 

4. Nastavte činnosti, ktoré sa majú spustiť alarmom cudzieho zásahu, a plán. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

5. Kliknite na položku Save. 
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Konfigurácia alarmu detekcie zvuku 

Kamera dokáže detegovať signály vstupu zvuku pre výnimky. Ak zvýšenie alebo zníženie hlasitosti prekročí 
nastavený limit alebo ak vstupná hlasitosť dosiahne prahovú hodnotu, kamera bude hlásiť alarm a spustí 
nastavené činnosti. Uistite sa, že zariadenie vstupu zvuku je správne pripojené ku kamere a vstup zvuku je 
zapnutý podľa časti Konfigurácia vstupu alarmu. 

 

UPOZORNENIE! 
 Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v rámci aktuálneho webového rozhrania. 
 Činnosti spustené alarmom sa môžu meniť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho 

webového rozhrania. 

 

1. Kliknite na položky Setup > Events > Common Alarm >Audio Detection. 

 
2. Vyberte možnosť Enable pre položku Audio Detection,vyberte typ detekcie a nastavte rozdiel alebo 

prahovú hodnotu. Ak chcete detekciu zvuku vypnúť, zrušte začiarknutie políčka Enable. 

Nasledujúca tabuľka obsahuje popis niektorých hlavných parametrov. 

Parameter Popis 

Detection 
Type 

 Náhle zvýšenie: Alarm sa bude hlásiť, ak zvýšenie hlasitosti prekročí rozdiel. 
 Náhle zníženie: Alarm sa bude hlásiť, ak zníženie hlasitosti prekročí rozdiel. 
 Náhla zmena: Alarm sa bude hlásiť, ak zvýšenie alebo zníženie hlasitosti prekročí rozdiel. 
 Prahová hodnota: Alarm sa bude hlásiť, ak hlasitosť prekročí prahovú hodnotu. 

Difference 

 Prahová hodnota: Po nastavení hlasitosti na možnosť prahovej hodnoty sa alarm bude 
hlásiť po prekročení prahovej hodnoty. 

 Rozdiel: rozdiel medzi dvomi hlasitosťami. Alarm sa bude hlásiť, ak zvýšenie alebo 
zníženie hlasitosti prekročí rozdiel. 

Poznámka: 
 Škála v rámci oblasti detekcie zvuku sa používa na meranie hlasitosti. 
 Výsledky detekcie zvuku sa zobrazujú v reálnom čase. Červená časť označuje 

zaznamenané alarmy detekcie zvuku. 
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Parameter Popis 

 

 

 

3. Podľa potreby nastavte činnosti spustené alarmom a rozpis aktivácie. Podrobné kroky nájdete 
v popisoch činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

4. Kliknite na položku Save. 

Konfigurácia vstupu alarmu 

Kamera dokáže prijímať informácie o alarmoch zo zariadenia tretej strany. Ak chcete používať túto funkciu, 
je potrebné najprv nakonfigurovať nasledujúce informácie pre vstup alarmu: port, názov alarmu, typ 
alarmu (normálne otvorený alebo normálne zatvorený) a čas hlásenia alarmu. 

 

UPOZORNENIE!  
 Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 
 Činnosti spustené alarmom sa môžu meniť v závislosti od modelu. Podrobnosti nájdete v rámci aktuálneho 

webového rozhrania. 

 

1. Kliknite na položky Setup > Events > Common Alarm > Alarm Input. 

Škála Hlasitosť 

Rozdiel 
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2. Vyberte alarm a nastavte názov alarmu. 

3. Vyberte možnosť N.O. Alebo N.C. Podľa typu zariadenia vstupu alarmu tretej strany. Napríklad, ak 
zariadenie vstupu alarmu tretej strany je normálne otvorené, v tejto časti je potrebné vybrať N.O., aby 
kamera mohla prijímať informácie o alarmoch zo zariadenia tretej strany. 

4. Nastavte činnosti, ktoré sa majú spustiť vstupom alarmu, a plán. Podrobné kroky nájdete v popisoch 
činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

5. Kliknite na položku Save. 

Konfigurácia výstupu alarmu 

Po spustení výstupu alarmu pomocou alarmu detekcie pohybu (booleovský alarm) kamera môže odoslať 
informácie o alarme do zariadenia tretej strany, ak je výstup alarmu správne nastavený na možnosti 
normálne otvorený alebo normálne zatvorený. Trvania výstupu alarmu je konfigurovateľné. 

 

UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Setup > Events > Common Alarm > Alarm Output.  
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2. Vyberte alarm a nastavte názov alarmu. 

3. Nastavte stav na N.O. (predvolené nastavenie) a nastavte trvanie alarmu. 

4. Nastavte činnosti, ktoré sa majú spustiť vstupom alarmu, a plán. Podrobné kroky nájdete v popisoch 
činností spustenými alarmom v časti Konfigurácia alarmu detekcie pohybu. 

5. Kliknite na položku Save. 

 

POZOR! 
Pri zapínaní zariadení postupujte presne podľa poradia, aby ste predišli poškodeniu komponentov 
kamery:  
1. Skontrolujte, či je typ alarmu nastavený na Normally Open (predvolené nastavenie) a či sú kamera 

a zariadenie výstupu alarmu vypnuté.  
2. Po dokončení pripojenia najprv zapnite kameru a potom zapnite zariadenie výstupu alarmu. 

 

Úložisko pamäťovej karty 

 UPOZORNENIE! 
 Niektoré modely nepodporujú túto funkciu. Funkcia sa môže líšiť v závislosti od modelu. 

Podrobnosti nájdete v popise aktuálneho modelu. 
 Ak sa kamera používa v samostatnom režime, odporúča sa úložisko na strane kamery. Keď sa 

kamera spravuje pomocou centrálneho servera správy, je potrebné zastaviť úložisko na strane 
kamery, aby sa neovplyvnila služba dodatočného nahrávania vyrovnávacej pamäte. 

 

Nastavenie úložiska na strane kamery 

Úložisko na strane kamery sa používa na ukladanie údajov a snímok priamo na pamäťovú kartu. Ak sa 
kamera používa v samostatnom režime, odporúča sa úložisko na strane kamery. 

Manuálne úložisko 

Ak je manuálne úložisko zapnuté, kamera nahráva živé video opakovane. 
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1. Kliknite na položky Setup > Storage > Storage. 

 
V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne. 

 

2. Spustite úložisko na strane kamery a podľa potreby upravte nastavenia. Nasledujúca tabuľka obsahuje 
popis niektorých hlavných parametrov. 

Parameter Popis 

Storage 
Medium 

Typ zdroja úložiska. 

Poznámka: 
 Ak chcete formátovať pamäťovú kartu, najprv vypnite funkciu úložiska karty. Potom 

kliknite na položku Format a na položku OK, aby ste potvrdili úkon. Po dokončení 
formátovania sa systém reštartuje. 

 Zobrazia sa informácie o celkovom a voľnom priestore. 

Data 
Overwrite 
Policy 

 Prepísanie: Ak na pamäťovej karte nie je žiadny voľný priestor, nové údaje opakovane 
prepíšu existujúce údaje. 

 Zastavenie: Ak na pamäťovej karte nie je žiadny voľný priestor, nové údaje sa neuložia 
na pamäťovú kartu. 

Post-Record(s) V prípade nahrávania spusteného alarmom dĺžka časového obdobia, počas ktorého 
pokračuje nahrávanie po ukončení alarmu. 
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3. Kliknite na položku Save. 

Plánované ukladanie 

Ak je aktivované plánované ukladanie, kamera nahráva video na pamäťovú kartu počas určených období. 

1. Kliknite na položky Setup > Storage > Storage. 

 

V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne. 
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2. Vyberte položku Planned Storage a potom nastavte obdobia, počas ktorých bude kamera nahrávať 
video na pamäťovú kartu. 

3. Kliknite na položku Save. 

 UPOZORNENIE!  
 Plánované ukladanie nie je účinné, ak je aktivované manuálne úložisko aj plánované ukladanie. 
 Informácie o vyhľadávaní nahrávok na pamäťovej karte nájdete v časti Prehrávanie videa 

a sťahovanie pomocou úložiska na strane kamery. 

 

Nastavenie dodatočného nahrávania vyrovnávacej pamäte 

Kamera s centralizovanou správou môže používať pamäťovú kartu ako záložný úložný zdroj centrálneho 
servera správy. Ak je ukladanie z kamery do centrálneho ukladacieho zariadenia prerušené kvôli 
nestabilnému sieťovému pripojeniu, kamera automaticky spustí dodatočné nahrávanie vyrovnávacej 
pamäte a uloží videá na pamäťovú kartu. 

Po obnovení komunikácie medzi kamerou a záložným serverom a v prípade zapnutia zálohy nahrávania 
kamera automaticky prenesie video uložené na pamäťovej karte do zdroja úložiska záložného servera vo 
forme súboru. 

 UPOZORNENIE! 
Pred nastavením dodatočného nahrávania vyrovnávacej pamäte kamery skontrolujte nasledovné: 

 Pamäťová karta je správne nainštalovaná vnútri kamery. 
 Záložný zdroj sa pridal do centrálneho servera. 
 Záložný zdroj sa priradil kamere. 
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Vypnutie úložiska na strane kamery 

1. Kliknite na položky Setup > Storage > Storage. 

 

V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne. 

 

2. Nastavte položku Edge Storage na možnosť Disable (čím sa vypne manuálne úložisko) a nastavte 
kapacitu videa. 

3. Kliknite na položku Save. 

Údržba systému 

 UPOZORNENIE!  
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

Zabezpečenie 

Správa používateľov 

V systéme existujú dva typy požívateľov: 
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 Správca: v tomto návode označený ako „admin“. Predvolené meno správcu je admin, toto meno nie je 
možné upraviť. Admin má kompletné oprávnenia a môže spravovať všetkých používateľov 
a zariadenia. V systéme je povolený iba jeden používateľ admin. 

 Bežný používateľ:v tomto návode označený ako „user“. User má oprávnenie iba na prehrávanie živého 
a nahratého videa. V systéme je povolených až 32bežných používateľov. 

Pridať používateľa je možné v rozhraní správy používateľov (v časti Setup > Security > User). 

Po úspešnom pridaní používateľa môžete zmeniť heslo zadaním nového hesla alebo odstránením 
používateľa vymazaním používateľského mena. 

 UPOZORNENIE! 
 Heslá môže zmeniť iba admin. Zmena používateľského mena alebo počas prihlásenia používateľa 

spôsobí odhlásenie používateľa. Používateľ na prihlásenie musí použiť nové používateľské meno 
a heslo. 

 Pridávať a odstrániť používateľov môže iba admin. Odstránenie používateľa počas prihlásenia 
používateľa spôsobí odhlásenie používateľa. Odstránený používateľ sa nemôže prihlásiť. 

 

Nastavenie zabezpečeného prenosu údajov 

Nastavte zabezpečený kanál na prenos údajov kvôli zaisteniu zabezpečenia. 

 UPOZORNENIE!  
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Setup > Network > Port. 

 
2. Zadajte číslo portu do textového poľa HTTPS Port. 

3. Kliknite na položku Save. 

4. Kliknite na položky Setup > Security > Network Security > HTTPS. 

 

5. Vyberte možnosť On pre položku HTTPS. Podľa potreby je možné importovať vlastný certifikát SSL. 

6. Kliknite na položku Save. 

Pri ďalšom prihlásení zadajte adresu vo formáte https://IP:HTTPS číslo portu, napr. 
https://192.168.0.13:443, aby ste vstúpili do režimu zabezpečeného kanála. Ak používate predvolený port 
HTTPS, zadajte https://IP. 

Overenie  

RTSP (protokol streamovania v reálnom čase) je protokol aplikačnej vrstvy. Ak chcete prenášať a ovládať 
zvuk a video, nastavte overenie RTSP vo webovom rozhraní. 

1. Kliknite na položky Setup > Security > Network Security > Authentication. 
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2. Vyberte režim overenia a potom kliknite na položku Save. 

Skrytie informácií o predajcovi 

Je možné, aby ste nastavili skrytie informácie o predajcovi sieťovej kamery vo webovom rozhraní. 

1. Kliknite na položky Setup > Security > Registration Info. 

 
2. V časti Registration Info vyberte možnosť On. 

3. Kliknite na položku Save. 

Väzba APR 

Táto funkcia chráni kameru pred útokmi ARP. Pred prístupom počítača ku kamere z inej siete je potrebné 
správne nastaviť bránu a adresu; ak nastavíte nesprávnu adresu MAC, umožní sa prístup iba počítačov 
s rovnakou sieťou LAN. 

1. Kliknite na položky Setup > Security > Network Security > ARP Protection. 

 

2. Začiarknite políčko, aby sa aktivovala funkcia väzby ARP a nastavte bránu a adresu MAC. 

3. Kliknite na položku Save. 

Filtrovanie adresy IP 

Filtrovanie adresy IP sa používa na povolenie alebo zakázanie prístupu z určitej IP adresy (adries). 

 UPOZORNENIE!  
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Setup > Security > Network Security > IP Address Filtering. 

 
2. Výberom možnosti On zapnete filtrovanie adresy IP. 

3. Vyberte režim filtrovania a potom zadajte IP adresu(-y). 

4. Kliknite na položku Save. 
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 UPOZORNENIE! 
 Ak je položka Filtering Mode nastavená na možnosť Whitelist, prístup ku kamere bude mať 

povolený iba pridaná IP adresa(-y). Ak je položka Filtering Mode nastavená na možnosť Deny 
Access, prístup ku kamere nebude mať povolený iba pridaná IP adresa(-y). 

 Prípustných je až 32 adries IP. Každú adresu IP je možné pridať iba raz. 
 Prvý bajt každej adresy IP musí byť 1-223 a štvrtý nesmie byť 0. Neprípustné adresy, ktoré nie je 

možné pridať, sú napríklad tieto: 0.0.0.0, 127.0.0.1, 255.255.255.255, 224.0.0.1. 

 

Zásady prístupu 

 UPOZORNENIE! 
Zapnutie nenáročného hesla neovplyvní používanie. Ak to vypnete a prihlásite sa pomocou slabého hesla, 
zobrazí sa stránka s výzvou na zmenu hesla. Na tejto stránke sa nenachádza žiadne tlačidlo zrušenia ani 
zatvorenia. Predvolené heslo sa považuje za slabé. 

 

1. Kliknite na položky Setup > Security > Network Security > Access Policy. 

 
2. Vyberte možnosť On, aby ste zapli telnet, nenáročné heslo a overenie MAC. 

3. Kliknite na položku Save. 

Vodotlač 

Vodotlač sa používa na šifrovanie vlastných informácií vo videu, aby sa predišlo neoprávnenému 
odstráneniu alebo zmene. 

 UPOZORNENIE! 
Túto funkciu podporujú iba niektoré modely kamier. 

 

1. Kliknite na položky Setup > Security > Watermark. 

 

2. Vyberte možnosť On, aby ste zapli vodotlač a potom zadajte obsah vodotlače. 

3. Kliknite na položku Save. 

Nastavenie času systému 

Na nastavenie času systému zariadenia môžete použiť nasledujúce spôsoby. 

Manuálne nastavenie alebo synchronizácia času systému 

1. Kliknite na položky Setup > Common > Time a potom kliknite na kartu Time. 
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2. Vyberte režim synchronizácie. 

3. Nastavte správne časové pásmo a čas systému. Môžete kliknúť aj na položku Sync with Computer 
Time, aby sa nastavenie času kamery synchronizovalo s časom počítača. 

4. Kliknite na položku Save. 

Synchronizácia so serverom NTP 

1. Kliknite na položky Setup > Common > Time a potom kliknite na kartu Time. 

 
2. Nastavte položku Sync Mode na možnosť Sync with NTP Server a potom nastavte adresu IP servera 

NTP a aktualizujte interval. 

3. Kliknite na položku Save. Kamera bude pravidelne synchronizovať čas so serverom NTP. 

Nastavenie letného a zimného času (DST) 

1. Kliknite na položky Setup > Common > Time a potom kliknite na kartu DST. 

 

2. Vyberte možnosť On pre položku DST, nastavte počiatočný čas, koncový čas a posun letného 
a zimného času. 

3. Kliknite na položku Save. 

Nastavenie serverov 

Inteligentný server 

Ak sa mimoriadne citlivá kamera spravuje centrálnym serverom, je potrebné nakonfigurovať inteligentný 
server. 

 UPOZORNENIE! 
 Inteligentný server podporujú iba niektoré modely kamier. 
 Ak chcete používať snímku tváre, je potrebné nakonfigurovať server TMS, na ktorý sa budú snímky 

nahrávať. 

 

1. Kliknite na položky Setup > Common > Server a potom kliknite na kartu Intelligent Server. 
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2. Nastavte adresu IP servera TMS a dokončite ostatné nastavenia. 

3. Kliknite na položku Save. 

Konfigurácia režimu sériového portu 

Sériový port RS485 sa používa na výmenu údajov so zariadením tretej strany. Nastavenia sériového portu 
kamery musia súhlasiť s nastaveniami pripojeného zariadenia tretej strany. 

 UPOZORNENIE! 
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

Ovládanie PTZ 

Ak chcete ovládať kameru PRZ prostredníctvom zariadenia tretej strany, je potrebné nastaviť položku Port 
Mode na možnosť PTZ Control.  

Odoslaním príkazov ovládania PTZ v súlade s protokolom PELCO-D prostredníctvom portu RS485 môžete 
ovládať kameru PTZ bez používania ovládacieho panela PTZ. 

1. Kliknite na položky Setup > System > Ports & Devices a potom kliknite na kartu Serial Port. 

  

2. Vyberte možnosť PTZ Control z rozbaľovacieho zoznamu Port Mode. Nasledujúca tabuľka obsahuje 
popis niektorých hlavných parametrov. 
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Parameter Popis 

PTZ Protocol 

Nastavte protokol PTZ, ktorý kanál podporuje. 

Poznámka: 
 Tento parameter je možné nastaviť len vtedy, keď je položka Port Mode nastavená na 

možnosť PTZ Control.  
 Keď je položka PTZ Protocol nastavená na možnosť INTERNAL-PTZ, kamera sa môže 

pripojiť k externému PTZ bez použitia sériového portu (parametre sériového portu sú 
sivé). V tomto prípade je potrebné pripojiť k objektívu iba rozhrania priblíženia 
a zaostrenia kamery a potom môžete používať PTZ ako interné PTZ. 

PTZ Mode 

 Priorita vstavaného PTZ: Po výbere tejto možnosti sa kamera najprv pokúsi ovládať PTZ 
(napr. priblíženie alebo zaostrenie) sama namiesto možnosti pomocou externého PTZ. 
V prípade činností, ktoré kamera nedokáže uskutočniť, použije externé PTZ. 

 Priorita externého PTZ: Kamera sa najprv pokúsi ovládať PTZ pomocou PTZ pripojeného 
prostredníctvom sériového portu. 

Poznámka: 
 Tento parameter je možné nastaviť len vtedy, keď je položka Port Mode nastavená na 

možnosť PTZ Control. 
 Keď je vybratá možnosť INTERNAL-PTZ, tento parameter je vždy nastavený na možnosť 

Built-in PTZ Priority a nie je potrebné pripojiť kameru k externému PTZ prostredníctvom 
sériového portu. Ovládanie prostredníctvom externého PTZ nebude účinné, aj keď sa 
kamera pripojila k externému PTZ. 

 Tento parameter nastavte podľa potreby. Uistite sa, že sú správne pripojené rozhrania 
týkajúce sa ovládanie PTZ. 

Address Code 

Nastavte kód adresy pre PTZ. 

Poznámka: 
Tento parameter je možné nastaviť len vtedy, keď je položka Port Mode nastavená na 
možnosť PTZ Control a položka PTZ Protocol nie je nastavená na možnosť INTERNAL-PTZ. 

 

3. Kliknite na položku Save. 

Transparentný kanál 

Sériový port RS485 sa používa na dosiahnutie transparentného prenosu údajov v prípade zariadenia tretej 
strany. Transparentný kanál sa používa hlavne na dosiahnutie transparentného prenosu údajov medzi 
dvomi zariadeniami. 

 UPOZORNENIE!  
 Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 
 Uistite sa, že ste položku kamery Port Mode nastavili na možnosť Trans-Channel. 

 

1. Kliknite na položky Setup > System > Ports & Devices a potom kliknite na kartu Serial Port. 
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2. Vyberte možnosť Trans-Channel z rozbaľovacieho zoznamu Port Mode. 

3. Vyberte možnosť Enable pre položku Trans-Channel. 

4. Zadajte adresu IP miesta určenia a číslo portu (adresa IP a číslo portu, ku ktorým sa transparentný 
kanál pripája). 

5. Kliknite na položku Save. 

OSD 

Ak chcete zobraziť informácie zo zariadenia tretej strany v rámci zobrazenia na obrazovke (OSD), je 
potrebné vybrať OSD ako režim portu. 

Kamera prijme informácie zo zariadenia tretej strany prostredníctvom sériového portu RS485, preloží 
prijaté informácie a potom och zobrazí na OSD. 

 UPOZORNENIE! 
Ak chcete, aby kamera správne prekladala informácie prijaté zo zariadenia tretej strany, uistite sa, že 
informácie odoslané zariadením tretej strany prostredníctvom sériového portu vyhovujú formátu údajov 
špecifikovanému našou spoločnosťou. Ďalšie podrobnosti vám poskytne predajca. 

 

1. Kliknite na položky Setup > System > Ports & Devices a potom kliknite na kartu Serial Port. 

 

2. Vyberte možnosť OSD z rozbaľovacieho zoznamu Port Mode. Vyberte možnosť Enable OSD Report 
(údaje OSD sa nahrajú do platformy). 
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3. Kliknite na položku Save. 

Transparentný kanál ONVIF 

Prenos údajov uskutočňujte prostredníctvom transparentného kanála (ONVIF) medzi portom kamery RS485 
a zariadením tretej strany. 

1. Kliknite na položky Setup > System > Ports & Devices a potom kliknite na kartu Serial Port. 

 

2. Nastavte položku Port Mode na možnosť Select Trans-Channel via ONVIF. 

3. Kliknite na položku Save. 

Ovládanie stierača 

Pred ovládaním stierača je potrebné nastaviť parametre stierača. 

 UPOZORNENIE!  
Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Setup > System > Ports & Devices a potom kliknite na kartu External Device. 

 

2. Nastavte riadiaci režim stierača. Nasledujúca tabuľka obsahuje popis niektorých hlavných parametrov. 

Parameter Popis 

Serial Port Stierač sa ovláda pomocou pokynov PELCO-D; preto je potrebné nastaviť protokol PTZ na 
možnosť PELCO-D. Podrobnosti nájdete v časti Ovládanie PTZ. 

Alarm Input/ 
Output Na otvorenie a zatvorenie obvodu a ovládanie stierača používajte vstup a výstup alarmu. 

 

Zobrazenie stavu zariadenia 

Aktuálny stav kamery je možné zobraziť. 

1. Kliknite na položky Setup > Common > Basic Info. 
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2. Kliknite na položku Refresh a získate najnovšie informácie stave. 

3. Prezrite si informácie o zariadení. 

Stav úložiska fotografií 

Zobrazte aktuálny stav úložiska fotografií. Kompletné postupy týkajúce sa úložiska nájdete v časti Úložisko 
pamäťovej karty. 

 UPOZORNENIE!  
Túto funkciu podporujú iba modely s funkciou úložiska. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položku Photo. 

 

2. Kliknite na položku Refresh a vykonáte aktualizáciu stavu úložiska. 

3. V oblasti Image List je možné exportovať alebo odstrániť fotografie. 

Inovácia zariadenia 

Ak sa zariadenie spravuje pomocou centrálneho servera správy a chcete inovovať zariadenia v dávkovom 
režime, odporúčame vykonať inováciu prevádzky na centrálnom serveri. Podrobné kroky nájdete návode na 
použitie centrálneho servera správy. 

1. Kliknite na položky Setup > System > Maintenance. 

 
2. V časti Software Upgrade kliknite na položku Browse a vyberte správny súbor inovácie. 
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3. Kliknite na položku Upgrade a potvrďte, čím sa inovácia spustí. Po dokončení inovácie sa kamera 
automaticky reštartuje. Niektoré zariadenia podporujú inováciu zavádzacieho programu. Inováciu 
spustíte výberom položky Upgrade Boot Program. 

4. Môžete kliknúť na položku Detect a skontrolovať nové dostupné verzie na upgrade z cloudu. 

 UPOZORNENIE! 
 Musíte použiť správny súbor inovácie kamery. V opačnom prípade sa môžu vyskytnúť neočakávané 

výsledky. 
 Súbor inovácie je súbor formátu ZIP a musí obsahovať všetky potrebné súbory. 
 Zavádzací program načítava operačný systém a následne sa systém spustí. Funkcia inovácie 

zavádzacieho programu je predvolene vypnutá a prebehne iba inovácia kamery na najnovšiu 
verziu. Ak je to zapnuté, prebehne inovácia kamery aj zavádzacieho programu. Operačný systém 
nasledujúcich nových verzií sa môže vhodne inovovať a kamera sa môže inovovať zvyčajným 
spôsobom. 

 Počas inovácie zabezpečte normálne napájanie. Po dokončení inovácie sa zariadenie automaticky 
reštartuje. 

 

Reštartovanie systému 

1. Kliknite na položky Setup > System > Maintenance. 

 
2. V časti Device Restart kliknite na položku Restart. Po potvrdení úkonu sa zariadenie automaticky 

reštartuje.  

 
POZOR! 
Tento úkon vykonávajte obozretne, pretože reštartovanie systému preruší prebiehajúcu službu. 

 

Importovanie a exportovanie súboru systémovej konfigurácie 

Aktuálne konfigurácie kamery je možné exportovať a uložiť do počítača alebo na externé úložné médium. 
Môžete aj rýchlo obnoviť konfigurácie pomocou importovania záložných konfigurácií uložených v počítači 
alebo na externom úložnom médiu naspäť do kamery. 

 
POZOR!  

 Po uskutočnení operácie Default (Predvolené) sa všetky nastavenia obnovia na predvoľby z výroby 
okrem nasledujúcich: prihlasovacie heslo správcu systému, nastavenia siete a čas systému. 

 Uistite sa, že importujete správny konfiguračný súbor kamery. V opačnom prípade sa môžu 
vyskytnúť neočakávané výsledky. 

 Po úspešnom importe konfiguračného súboru sa kamera reštartuje. 

 

1. Kliknite na položky Setup > System > Maintenance. 
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2. Ak chcete importovať konfigurácie, ktoré ste zálohovali, kliknite na položku Browse vedľa tlačidla 
Import a vyberte konfigurácie, ktoré chcete importovať, a potom kliknite na položku Import. Zobrazí 
sa výsledok. 

3. Ak chcete exportovať konfigurácie, kliknite na položku Export a vyberte priečinok miesta určenia. 

4. Ak chcete obnoviť predvolené konfigurácie, kliknite na položku Default a potom potvrďte úkon. 
Zariadenie sa reštartuje a obnovia sa predvolené konfigurácie. 

Zhromažďovanie informácií diagnostiky 

Informácie diagnostiky zahŕňajú denníky a systémové konfigurácie. Informácie diagnostiky je možné 
exportovať do počítača. 

1. Kliknite na položky Setup > System > Maintenance. 

 

2. V časti Diagnosis Info kliknite na položku Export a vyberte priečinok miesta určenia. 

 UPOZORNENIE! 
 Informácie diagnostiky sa exportujú do lokálneho priečinka vo forme skomprimovaného súboru. 

Súbor je potrebné dekomprimovať pomocou nástroja, akým je napr. WinRAR, a následne ho otvoriť 
pomocou textového editora. 

 Výberom položky Collect Image Debugging Info je možné zobraziť video súčasne s informáciami 
ladenia, čo zjednodušuje riešenie problémov. 

Konfigurácia zaostrenia 

Zariadenie môže nastaviť rýchlosť automatického zaostrenia podľa minimálnej vzdialenosti zaostrenia. Na 
zachytenie jasných objektov sa odporúča, aby bola minimálna vzdialenosť zaostrenia nastavená na kratšiu 
ako je vzdialenosť medzi objektmi a objektívom, napríklad ak je minimálna vzdialenosť zaostrenia 3 m, 
objekty do vzdialenosti 3 m od objektívu budú rozostrené. 

 UPOZORNENIE! 
Túto funkciu podporujú iba zariadenia s automatickým zaostrením. Podrobnosti nájdete v popise 
aktuálneho modelu. 

1. Kliknite na položky Setup > System > Maintenance. 

 

2. V časti Focus nakonfigurujte položky Min. Focus Distance (jednotka: cm) a Max. Zoom Ratio. 

3. Kliknite na položku OK. 
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Výška montáže zariadenia 

Zadajte skutočnú výšku nainštalovanej infračervenej kupolovej kamery od terénu, aby mohla kupolová 
kamera automaticky nastaviť infračervenú lampu. 

 UPOZORNENIE! 
Túto funkciu podporujú iba niektoré infračervené kamery. Podrobnosti nájdete v popise aktuálneho 
modelu. 

1. Kliknite na položky Setup > System > Maintenance. 

 

2. Zadajte skutočnú výšku nainštalovanej infračervenej kupolovej kamery od terénu. 

3. Kliknite na položku OK. 

Parameter kamier v režime rybieho oka 

Parametre rybieho oka je potrebné nastaviť vhodne podľa aktuálneho režimu montáže, aby sa video 
správne zobrazovalo. 

 UPOZORNENIE! 
Túto funkciu podporujú iba kamery v režime rybie oko. Podrobnosti nájdete v popise aktuálneho modelu. 

 

1. Kliknite na položky Live View > Mount. Vyberte režim montáže. Vybratý režim montáže musí súhlasiť 
so skutočným režimom montáže. 

 
V prípade niektorých modelov kamier sa stránke zobrazuje nasledovne. 
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2. Nastavte parametre. Nasledujúca tabuľka obsahuje popis niektorých hlavných parametrov. 

Parameter Popis 

 

 

 

 

 

 

 

 

 

 

 

Jedenásť režimov zobrazenia: 

 Pôvodný obraz 
 Panoramatický 
 Panoramatický + 3 PTZ 
 Panoramatický + 4 PTZ 
 Panoramatický + 8 PTZ 
 360° panoramatický + 1 PTZ 
 180° panoramatický 
 Rybie oko + 3 PTZ 
 Rybie oko + 4 PTZ 
 360° panoramatický + 6 PTZ 
 Rybie oko + 8 PTZ 
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Parameter Popis 

 

 

 

Tri režimy montáže: 

 Stropná 

 Nástenná 

 Stolová 

Poznámka: 
Vybratý režim montáže musí súhlasiť so skutočným režimom montáže. 

 

4  Živý náhľad 

Živý náhľad predstavuje prehrávanie živého videa (zvuk a video v reálnom čase) prijatého z kamery v okne 
prostredníctvom webového rozhrania. 

Ak sa prihlásite a políčko Live View je začiarknuté, živé video sa predvolene zobrazí. Vstúpiť alebo opustiť 
režim celej obrazovky môžete pomocou dvojitého kliknutia v okne. 

 

Panel nástrojov živého náhľadu 

 UPOZORNENIE! 
Podporované úkony živého náhľadu sa môžu líšiť v závislosti od modelu kamery. Informácie úkonoch, 
ktoré kamera podporuje, nájdete v rámci webového rozhrania. 

 

Tlačidlo Popis 

/  Prehrávanie/zastavenie živého videa. 

 

Nastavenie hlasitosti výstupu prehrávača medií v počítači. 
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Tlačidlo Popis 

 

Nastavenie hlasitosti mikrofónu v počítači počas zvukovej komunikácie medzi 
počítačom a kamerou. 

 

Vytvorenie snímky aktuálneho obrazu zobrazeného na počítači. 

Poznámka:  
Cesta na ukladanie snímok je nastavená v časti System Configuration. 

/  

Spustenie/zastavenie lokálneho nahrávania. 

Poznámka:  
Cesta na ukladanie lokálnych nahrávok je nastavená v časti System 
Configuration. 

/  Spustenie/zastavenie komunikácie medzi počítačom a kamerou. 

/  
Spustenie/zastavenie digitálneho priblíženia. Podrobnejšie informácie nájdete v 
časti Použitie digitálneho priblíženia. 

/  
Spustenie/zastavenie zaostrenia oblasti. Podrobnejšie informácie nájdete v 
časti Použitie zaostrenia oblasti. 

/  
Spustenie/zastavenie polohovania 3D. Podrobnejšie informácie nájdete v časti 
Použitie polohovania 3D. 

 Zobrazenie/skrytie ovládacieho panela PTZ. 

 

Nastavenie pomeru zobrazenia obrazu v okne. Ak chcete zobraziť obrazy 
s vysokým rozlíšením napr. v pôvodnom pomere 16 : 9, vyberte položku Scale; 
ak ich chcete zobraziť v súlade s veľkosťou okna, vyberte položku Stretch; ak ich 
chcete zobraziť vo veľkosti pôvodného obrazu, vyberte položku Original. 

 

Resetovanie pomeru straty paketov na nulu. 

Poznámka:  
Toto tlačidlo sa zobrazí na premenlivom paneli nástrojov po posunutí kurzora 
myši do okne živého náhľadu. 

 

Zobrazenie informácií o pomere straty paketov a bitovej rýchlosti v spodnej 
časti okna. 

Poznámka: 

Toto tlačidlo sa zobrazí na premenlivom paneli nástrojov po posunutí kurzora 
myši do okne živého náhľadu. 

Ak kliknete na toto tlačidlo, informácie sa budú zobrazovať stále. Po ďalšom 
kliknutí sa informácie budú zobrazovať, iba ak posunutie kurzor myši nad okno 
alebo ak ho umiestnite do spodnej časti. Ak kurzor myši ostane v okne asi 
3 sekundy alebo prejde mimo okna, informácie zmiznú. 

 Kliknutím na toto tlačidlo sa otvorí stránka nastavenia obrazu.  

 Zobrazenie v režime celej obrazovky. 

 

 

 

Výber streamu živého videa, ktorý kamera podporuje: hlavný stream, vedľajší 
stream alebo tretí stream. 
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Zobrazenie určitých oblastí obrazu 

Digitálne priblíženie, zaostrenie oblasti a polohovanie 3D umožňujú získať viac podrobností určitej časti 
obrazov. Pomocou digitálneho priblíženia sa zväčšuje obraz, pričom dochádza k strate kvality obrazu, zatiaľ 
čo polohovanie 3D zväčší obraz bez tejto straty. 

Použitie digitálneho priblíženia 

 UPOZORNENIE! 
Podporované úkony živého náhľadu sa môžu líšiť v závislosti od modelu kamery. Informácie úkonoch, 
ktoré kamera podporuje, nájdete v rámci webového rozhrania. 

 

1. Na stránke Live View kliknite na panel nástrojov . 

 
2. Kliknite a podržte tlačidlo myši a potom potiahnite zhora nadol (nakreslíte obdĺžnik), aby ste určili 

oblasť. Ak chcete obnoviť veľkosť pôvodného obrazu a priblížiť v iných oblastiach obrazu, kliknite 
pravým tlačidlom myši. 

3. Ak chcete postup ukončiť, kliknite na položku . 

Použitie zaostrenia oblasti 

 UPOZORNENIE! 
Podporované úkony živého náhľadu sa môžu líšiť v závislosti od modelu kamery. Informácie úkonoch, 
ktoré kamera podporuje, nájdete v rámci webového rozhrania. 

 

1. Na stránke Live View kliknite na panel nástrojov . 
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2. Kliknite a podržte tlačidlo myši a potom potiahnite zhora nadol (nakreslíte obdĺžnik), aby ste určili 

oblasť. 

3. Ak chcete postup ukončiť, kliknite na položku . 

Použitie polohovania 3D 

 UPOZORNENIE! 
Táto funkcia je dostupná iba v prípade sieťových PTZ kamier a sieťových skrinkových kamier vybavených 
motorizovaným objektívom a PTZ. Podrobnosti nájdete v popisoch aktuálnych modelov. 

 

1. Na stránke Live View kliknite na panel nástrojov . 

 
2. Kliknite a podržte tlačidlo myši a potom potiahnite zhora nadol (nakreslíte obdĺžnik), aby ste určili 

oblasť. Spätným potiahnutím (zdola nahor) vykonáte oddialenie. 
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3. Ak chcete postup ukončiť, kliknite na položku . 

Živý náhľad kamier v režime rybie oko 

 

UPOZORNENIE! 
 Túto funkciu podporujú iba sieťové kamery v režime rybie oko. Podrobnosti nájdete v popisoch 

aktuálnych modelov. 
 Obraz ukážky na internete sa môže líšiť v závislosti od nastavení rybieho oka kamery. Pred 

spustením živého náhľadu nastavte parametre rybieho oka (pozri časť Parameter kamier v režime 
rybieho oka) a režim rybieho oka (pozri časť Konfigurácia videa) kamery.  

Režimy zobrazenia zahŕňajú tri hlavné typy: pôvodný obraz, rybie oko a PTZ, panoramatický a PTZ. 
V rôznych režimoch montáže sa obrazy zobrazujú rôzne. Nasledujúca časť obsahuje ako príklad upevnenie 
na stenu. 

Ak vyberiete pôvodný obraz, obrazy rybieho oka sa zobrazia nasledovne. 

 
Ak vyberiete panoramatický, obrazy s potlačeným skreslením sa zobrazia nasledovne. 
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UPOZORNENIE! 
Ak sa používa upevnenie na strop alebo stolové upevnenie, panoramatický obraz (dva 180° obrazy) je 
obrazom s potlačeným skreslením obrazu náhľadu rybieho oka (360° obraz). Namontujte kameru 
v príslušnom pozorovacom uhle podľa aktuálnych požiadaviek sledovania. 
Ak je kamera nainštalovaná napr. na stope, cieľ sledovania sa zobrazí v hornej časti panoramatického 
obrazu, keď je uhol priesečníka medzi výstupom kábla zariadenia (logo) a cieľom sledovania v smere 
pohybu hodinových ručičiek 135°. 
 

 
 

Po výbere režimu ukážky panoramatický + 4PTZ zo zoznamu vpravo sa predvolene zobrazia 4 lokálne obrazy 
zľava doprava a zhora nadol. Na každom lokálnom obraze je možné vykonať úkony ovládania PTZ 
a priblíženia (podľa zobrazenia na obrázku nižšie). 

 

LOGO

 360° obraz rybieho oka 
v režim ukážky rybieho oka 

Panoramatický obraz 
v panoramatickom  

prežime ukážky 

Poloha cieľa sledovania  
(napr. riadenie prístupu) 

Cieľ 

Výstup 
kábla 

Spodná 
časť 
zariadenia 
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5  Prehrávanie videa a sťahovanie pomocou úložiska 
na strane kamery 

 UPOZORNENIE! 
 Úložisko na strane kamery predstavuje nahrávanie videa na pamäťovú kartu rozhrania zariadenia 

(väčšinou kamera). Lokálne nahrávanie predstavuje nahrávanie videa do lokálneho počítačového 
klienta. 

 Pred prehrávaním videa pomocou úložiska na strane kamery skontrolujte, či má kamera 
nainštalovaná pamäťovú kartu a nakonfigurované úložisko. 

 Niektoré modely nepodporujú túto funkciu. Podrobnosti nájdete v popisoch aktuálnych modelov. 

 

Prehrávanie videa 

1. Kliknite na položku Playback na domovskej stránke. 

 
2. Vyberte dátum v kalendári. 

3. Kliknite na položku Query. 

4. V časti Results dvakrát kliknite na časové obdobie, aby sa spustilo prehrávanie nahrávky. 

Stiahnutie 

1. Kliknite na položku Playback na domovskej stránke. 
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2. Vyhľadajte video v rámci určitého obdobia. Výsledok sa zobrazí v zozname. 

3. Vyberte príslušné video a kliknite na položku Download. Video sa stiahne podľa lokálnej cesty 
z pamäťovej karty (lokálnu cestu je možné zmeniť v časti Local Settings). 

4. Kliknite na položku Open , aby sa zobrazil priečinok uloženia stiahnutého videa. 

6  Ovládanie PTZ 

Táto funkcia je dostupná iba v prípade PTZ kupolových kamier alebo skrinkovej kamery nainštalovanej na 
motore posunu/naklonenia.  

 UPOZORNENIE! 
 Niektoré funkcie ovládanie objektívu sú použiteľné v prípade kamier vybavených motorizovaným 

objektívom. 
 Tlačidlá ovládania PTZ sa môžu líšiť v závislosti od modelu kamery. Informácie o tlačidlách 

ovládania, ktoré kamera podporuje, nájdete v rámci webového rozhrania. 

 

Panel nástrojov ovládania PTZ 

Položka Popis 

Preset 

Vyberte predvoľbu a kliknite na položku . Kamera PTZ prejde na vybratú 
predvoľbu. 

Ak chcete pridať predvoľbu, kliknite na položku . Ak chcete odstrániť predvoľbu, 
kliknite na položku . 

Patrol 

Vyberte dráhu hliadky a potom kliknite na položku , aby sa hliadka spustila.  

 Ak chcete upraviť dráhu hliadky, kliknite na položku . 

 Ak chcete pridať dráhu hliadky, kliknite na položku . 

 Ak chcete odstrániť dráhu hliadky, kliknite na položku . 

 

Nastavenie rýchlosti pohybu kamery PTZ. 
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Položka Popis 

 

Ovládanie smeru kamery PTZ a uvoľnenie ovládania. 

/  

/  

/  

/  

/  

Zapnutie alebo vypnutie IR. 

Zapnutie alebo vypnutie stierača. 

Zapnutie alebo vypnutie ohrievača. 

Zapnutie alebo vypnutie osvetlenia. 

Zapnutie alebo vypnutie ovládania snehu. 

 

Nastavenie zaostrenia kamery. 

 

Nastavenie priblíženia kamery. 

 

Zväčšenie alebo zmenšenie priemeru clony. 

 

Klávesové skratky na ovládanie PTZ. Keď sa kurzor myši zmení na jeden z týchto 
tvarov v živom náhľade, kliknutím a podržaním ľavého tlačidla myši ovládate kameru 
PTZ. 

Poznámka: 
 Túto funkciu podporujú iba kupolové kamery PTZ a kamery PTZ. 
 Tieto tlačidlá sa nedajú použiť počas používania polohovania 3D alebo 

digitálneho priblíženia. 

 

Klávesové skratky na priblíženie alebo oddialenie pri živom náhľade. Približujete 
posúvaním kolieska dopredu, odďaľujete posúvaním kolieska dozadu. 

Poznámka: 
Túto funkciu podporujú iba kamery s motorizovaným objektívom. 

 

Nastavenie hliadky podľa predvoľby 

Nastavenie predvolieb 

Na karte Preset môžete spravovať predvoľby alebo vykonávať niektoré úkony ovládania kamery PTZ. 
Podrobnejšie informácie nájdete v časti Panel nástrojov ovládania PTZ. 

Pridanie predvoľby 

1. Na stránke Live View kliknite na ovládací panel Preset. 
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2. Nastavte kameru tak, aby smerovala do požadovanému smeru. 

3. Podľa potreby nastavte priblíženie a zaostrenie, aby ste získali optimálny obraz. 

4. Kliknite na položku , aby ste ju pridali ako predvoľbu. Zadajte číslo a názov predvoľby a potom 
kliknite na položku OK. 

Prechod na predvoľbu 

1. Na stránke Live View kliknite na ovládací panel Preset. 

 

2. Kliknite na položku  pre predvoľbu. Kamera PTZ prejde na vybratú predvoľbu. 

Odstránenie predvoľby. 

1. Na stránke Live View kliknite na ovládací panel Preset. 
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2. Kliknite na položku  pre predvoľbu a potom potvrďte odstránenie. 

Nastavenie hliadky 

Dráha hliadky je trasa, po ktorej kamera PTZ postupuje pri pohybe z jednej predvoľby na ďalšiu. Dĺžka 
časového obdobia, počas ktorého kamera PTZ zostáva na každej predvoľbe, je konfigurovateľná. V prípade 
kamery PTZ sú prípustné viaceré dráhy hliadky. 

Činnosti hliadky zahŕňajú prechod na predvoľbu a zotrvanie na predvoľbe určité časové obdobie pred 
prechodom na ďalšiu predvoľbu. Je možné nastaviť smer otáčania, priblíženie, rýchlosť otáčania, čas hliadky 
a čas zotrvania. Systém nahráva dráhu a pridáva ju do zoznamu činností. Môžete vybrať možnosť Keep 
Rotating, aby kamera PTZ postupovala po rovnakej dráhe a hliadkovala opakovane. 

Pridanie dráhy hliadky 

1. Na stránke Live View kliknite na ovládací panel Patrol. 

 

2. Kliknite na položku . 
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3. Na stránka Add Patrol zadajte ID a názov dráhy a potom kliknite na položku Add , aby ste pridali 
činnosť hliadky. Prípustných je až 64 činností. Ak je typ činnosti nastavený na možnosť Move Direction 
a Zoom, každý riadok obsahuje dve činnosti, takže prípustných bude 32 činností. Na nastavenie 
poradia činností sa používajú tlačidlá. 

Činnosti hliadky zahŕňajú: 

 prechod na predvoľbu a zotrvanie na predvoľbe určité časové obdobie pred prechodom na ďalšiu 
predvoľbu, 

 otočenie pri nastavenej rýchlosti v nastavenom smere počas určitého časového obdobia, priblíženie, 
zotrvania v nastavenej polohe určité časové obdobie alebo opakované hliadkovanie, ak je vybratá 
možnosť Keep Rotating. 

Odporúčame, aby typ prvej činnosti bol Go to Preset. 

4. Kliknite na položku OK. 

Nahrávanie dráhy hliadky 

1. Na stránke Live View kliknite na ovládací panel Patrol. 

 

2. Kliknite na položku , aby ste spustili nahrávanie dráhy hliadky. Počas nahrávania je možné nastaviť 

smer a priblíženie kamery. Systém nahráva pohyb a trasu kamery a pridáva ich do zoznamu činností. 

3. Kliknutím na položku  ukončíte nahrávanie. Následne sa dráha hliadky automaticky uloží ako dráha 
režimu. Kliknutím na položku  spustíte hliadku, prípadne kliknutím na položku  odstránite dráhu 
režimu. 
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Vytvorenie plánu hliadky 

1. Na stránke Live View kliknite na ovládací panel Patrol. 

 

2. Kliknite na položku . Zobrazí sa stránka na nastavenie plánov hliadky. 

3. Vyberte správny čas a dráhu hliadky. 

4. Vyberte položku Enable Patrol Plan. 

5. Kliknite na položku OK. 

Spustenie dráhy hliadky 

Po pridaní dráhy hliadky vyberte dráhu hliadky, ktorá sa má spustiť. 

1. Na stránke Live View kliknite na ovládací panel Patrol. 
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2. Kliknite na položku  v prípade dráhy hliadky, ktorú chcete spustiť. 

Úprava dráhy hliadky 

1. Na stránke Live View kliknite na ovládací panel Patrol. 

 

2. Kliknite na položku  v prípade dráhy hliadky, ktorú chcete upraviť a podľa potreby upravte 
nastavenia. 

Odstránenie dráhy hliadky 

1. Na stránke Live View kliknite na ovládací panel Patrol. 
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2. Kliknite na položku  v prípade dráhy hliadky, ktorú chcete odstrániť a potvrďte odstránenie. 

Nastavenie východiskovej polohy 
Ak sa nevykonáva žiadna činnosť počas určitého obdobia, kamera PTZ sa vráti do východiskovej polohy. 

 UPOZORNENIE! 
 Táto kamera je dostupná iba v prípade sieťových kamier PTZ. 
 Najprv je potrebné pridať predvoľby alebo dráhu hliadky. Podrobnosti nájdete v častiach Pridanie predvoľby

a Pridanie dráhy hliadky. 

 

1. Kliknite na položky Setup > PTZ > Home Position. 

 
2. Vyberte režim a ID. 

3. Kliknite na položku Save. 

Vzdialené ovládanie PTZ 
Keď sa používa platforma tretej strany a protokol PTZ sa s ňou nezhoduje, môžete na ovládanie PTZ nastaviť 
funkciu vzdialeného ovládania. 

 UPOZORNENIE! 
Túto funkciu podporujú iba kamery PTZ. 

 

1. Kliknite na položky Setup > PTZ > Remote Control. 
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2. Vyberte možnosť On, aby ste zapli Remote Control. Nastavte port prijímača a kód adresy. Nasledujúca 

tabuľka obsahuje popis niektorých hlavných parametrov. 

Akronym Popis  

Listener Port Lokálny port kamery, ktorým nemôže byť port, ktorý sa už používa. 
Predvolené nastavenie zmeňte, iba ak je to nevyhnutné. 

Address Code 
Kamera dokáže načítať kód adresy, ktorý sa nachádza v pokynoch. Kamera 
vykoná príkaz podľa pokynov, iba keď je kód adresy v pokynoch kódom 
adresy, ktorý je nakonfigurovaný v tomto dokumente. 

 

3. Kliknite na položku Save. 

Limit PTZ 

Nastavte limity otáčania, aby sa zabránilo tomu, že kamera PTZ zasiahne prekážky, ako napr. stenu. 

 UPOZORNENIE! 
Túto funkciu podporujú iba niektoré kamery PTZ. 

 

1. Kliknite na položky Setup > PTZ > PTZ Limit.  

 
2. Na otočenie kamery do určenej polohy použite smerové tlačidlá. 
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3. Kliknutím na položku  nastavíte aktuálnu polohu ako limit. Kliknite napr. na položku  v hornej 

časti a nastavíte horný limit. Kliknutím na položku  sa kamera otočí do aktuálnej polohy, ak sa 

zmenil smer. 

4. Zopakujte vyššie uvedené kroky, aby ste podľa potreby nastavili všetky limity (horný, dolný, ľavý, 
pravý). 

5. Kliknite na položku Save. 

6. Kliknite na položku Start PTZ Limit, aby sa nastavenie použilo. 

7. Kliknutím na položku  odstránite nastavenia a obnovíte limit. 

Obnovenie hliadky 
1. Kliknite na položky Setup > PTZ > Patrol. 

 

2. Nastavte čas obnovenia hliadky. 

3. Kliknite na položku Save. 

 

 

Príloha A – slovník 

Akronym Popis  

ARP Address Resolution Protocol 

CBR Konštantná bitová rýchlosť 

DNS Služba názvov domén 

DDNS Služba dynamických názvov domén 

DHCP Systém dynamického prideľovania adries 

Letný čas Letný čas 

FTP Protokol prenosu súborov 

GOP Skupina obrázkov 

GUI Grafické používateľské rozhranie 

HTTPS Hypertextový prenosový protokol 

IE Internet Explorer 

IMOS Multimediálny operačný systém pre IP 

IP Internetový protokol 
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Akronym Popis  

IPC IP kamera 

MTU Maximálna prenosová jednotka 

NTP Sieťový časový protokol  

OSD Zobrazenie na obrazovke 

PoE Napájanie cez Ethernet 

PPPoE Protokol point-to-point cez Ethernet 

PTZ Posun, naklonenie a priblíženie 

Oblasť záujmu Oblasť záujmu 

SMTP Jednoduchý protokol prenosu elektronickej pošty 

SSL Bezpečná objímková vrstva 

UNP Technológia Universal Network Passport 

USB Univerzálna sériová zbernica 

VBR Variabilná bitová rýchlosť 

WDR Široký dynamický rozsah 

 

Príloha B – často kladené otázky 

Čo robiť, ak sa pri prvom prihlásení do počítača so systémom Windows 7 nezobrazí výzva na inštaláciu 
platformy ActiveX? 

Odpoveď: Postupujte podľa týchto krokov na vypnutie UAC a potom sa opäť prihláste:  

1. Kliknite na tlačidlo Start a potom kliknite na položku Control Panel. 

2. V poli vyhľadávania zadajte uac a potom kliknite na tlačidlo Change User Account Control Settings.  

3. Posuňte jazdec do polohy Never Notify a potom kliknite na tlačidlo OK.  

4. Po vypnutí UAC sa opäť prihláste. 

 

Čo robiť, ak inštalácia platformy ActiveX zlyhala? 

Odpoveď: Ak inštalácia zlyhala, pridajte adresu IP kamery ako dôveryhodnú lokalitu: otvorte položku 
Internet Option v prehliadači IE, kliknite na kartu Security, kliknite na položku Trusted sites a potom 
kliknite na položku Sites, aby ste pridali webovú stránku.  

Ak používate systém Windows 7, najprv je potrebné uložiť súbor setup.exe do počítača, kliknúť pravým 
tlačidlom na súbor, vybrať položku Run as administrator a následne ho nainštalovať podľa pokynov. 

 

Čo robiť, ak sa pri prvom prihlásení živé video zlyhalo? 

Odpoveď: Vypnite bránu firewall na počítači a potom sa znova prihláste do webového rozhrania. 
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